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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Introduction
This guide is for system administrators and installers of the Ross Video ULTRIX-MODX-IO and its 
modules. This guide outlines the installation and configuration of your ULTRIX-MODX-IO blade and 
its modules. 

The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” outlines the features, and licenses available for the ULTRIX-MODX-IO.
• “Hardware Overview” provides an introduction to the ULTRIX-MODX-IO hardware features.
• “Installing the ULTRIX-MODX-IO” provides instructions for the basic physical installation of the 

ULTRIX-MODX-IO into an Ultrix router.
• “Installing a Module” provides outlines how to install a module into an ULTRIX-MODX-IO blade.
• “Populating the SFP Ports” outlines how to install an SFP module into a port on the 

ULTRIX-MODX-IO blade and its modules.
• “Cabling the AUX Ports” outlines the AUX ports cabling designations for the ULTRIX-MODX-IO 

blade when using specific licensed features of the Ultrix router.
• “ULTRIX-MOD-DPT” outlines the ULTRIX-MOD-DPT features, cabling designations, DashBoard 

interfaces, and configuration options.
• “ULTRIX-MOD-NDI” summarizes the features, cabling, and configuration of the ULTRIX-MOD-NDI 

module.
• “ULTRIX-MOD-SDI” outlines the hardware features, and cabling of the ULTRIX-MOD-SDI module.
• “ULTRIX-MOD-SFP” outlines the hardware features, and cabling of the ULTRIX-MOD-SFP module.
• “DashBoard Overview” provides a general overview of how to access the interfaces, tabs, and 

menus for an ULTRIX-MODX-IO blade and its modules in DashBoard.
• “Port Configuration” summaries the configuration options in DashBoard for the I/O ports.
• “Monitoring” summarizes how to monitor the ULTRIX-MODX-IO via the DashBoard interfaces.
• “Upgrading the Software” outlines how to use DashBoard to upgrade the ULTRIX-MODX-IO 

blade and the ULTRIX-MOD-NDI module in the field.
• “Technical Specifications” provides the specifications, such as pinouts and power consumption, 

for the ULTRIX-MODX-IO.

If you have questions pertaining to installation of this Ross Video product, contact us at the 
numbers listed in “Contacting Technical Support”. Our technical staff is always available for 
consultation, training, or service.

Related Publications
It is recommended to consult the following Ross Video documentation before installing and 
operating your ULTRIX-MODX-IO:

• DashBoard User Guide, Part Number: 8351DR-004
• UltriScape User Guide, Ross Part Number: 2101DR-018
• Ultrix and Ultricore Database Guide, Ross Part Number: 2201DR-109
• ULTRIX SFP Modules Guide, Ross Part Number: 2101DR-008
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 User Guide, Ross Part Number: 2101DR-004
• ULTRIX-FR12 User Guide, Ross Part Number: 2101DR-604

 The user documentation is available for download from our website.
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Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Save Layout dialog, click OK.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the ULTRIX-FR12 User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save,” you would click the File menu and then click Save.

Important Instructions
Star icons are used to identify important instructions or features. For example:

When the Ultrix router cannot connect to the network, a Message dialog opens to report the 
connection problem.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Toll Free Technical Support (North America): 1-844-652-0645
• Toll Free Technical Support (International): +800 1005 0100
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
The ULTRIX-MODX-IO enables broad signal format support on the Ultrix router using high-density 
hot-swappable I/O modules. Each ULTRIX-MODX-IO blade hosts four IO modules available with 
different video interfaces including support for compressed streams and embedded audio. Mix and 
match modules within a single blade to get the density and formats you need for your production.

Features
Each ULTRIX-MODX-IO blade supports:

• Up to four Plug-and-Play I/O modules
• Maximum 16 UHD IN + 16 UHD OUT
• GigE interface to frame ethernet network
• Color space of YUV 4:2:2 10-bit
• 384 channels of embedded audio
• Up to 3 x Ultriscape MV Licenses 
• Four AUX ports
• Up to 3 UHD Frame Syncs inputs
• 18 UHD Clean/Quiet Switch outputs
• An UltriMix matrix of 128 x 64

Before You Begin
You may also need to install the following license keys:

• Ultrimix-Dante — enables 64 x 64 input/output audio channels via ethernet on the AUX C port of 
the ULTRIX-MODX-IO blade.

 UltriStream and Ultrimix-Dante cannot be enabled simultaneously on the same slot. By enabling 
an Ultrimix-Dante license on a slot, an UltriStream cannot be enabled on the same slot until the 
Ultrimix-Dante license is disabled.

• Ultrimix-MXR — enables the configuration and use of audio mixer soft panels.
• UltriProc or UltriProc-3DLUT — a license key is required for each port that will be used by an 

UltriProc engine.
• Ultriscape — for each port that will be used to provide an Ultriscape head output.
• UltriSpeed — if the blade and/or its modules include an SFP-HDB-IN-12G, SFP-FIBER-12G, and/or 

SFP-HDB-OUT-12G.
• UltriSRC — for each port configured for an asynchronous MADI input.
• UltriStream — enables the encoding of one NDI stream of a configured Ultriscape Multiviewer 

Head per blade.
• UltriSync— a per input 3G frame sync license enabling alignment to router sync.
• Ultrisync-UHD —a per input frame sync license to support UHD video rates. Each slot supports up 

to 3 Ultrisync-UHD ports. Requires software version 4.2.0 or higher and is applicable only to the 
ULTRIX-HDBNC-IO, ULTRIX-SFP-IO, and ULTRIX-MODX-IO blades.

 Refer to the Ultrix User Guide for your router for more information on license keys.
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Hardware Overview
This chapter outlines the hardware features of the ULTRIX-MODX-IO.

Supported Routers
You can install the ULTRIX-MODX-IO into the following Ultrix routers:

• ULTRIX-NS-FR1
• ULTRIX-NS-FR2
• ULTRIX-FR5
• ULTRIX-NS-FR5
• ULTRIX-FR12

Hardware Features
This section provides an overview of the ports, connections, and other hardware features of the 
ULTRIX-MODX-IO.

Figure 1  ULTRIX-MODX-IO

1. USB 3.0 Port

This is an USB 3.0 Type A port and provides the ability for supported USB-serial converters to be 
attached for serial communications with the Ultrix router.

2. PSU Connection

Each ULTRIX-MODX-IO includes a power connector that requires a 15VDC connection to an 
external power supply. The blade supplies up to 15W per module.

 Refer to the Ross Ultrix Configuration Tool on our website, or contact Ross Technical Support, for 
help determining if this power connection is needed for your system.

3. AUX A-D Ports

The AUX ports are labeled as A-D starting with the leftmost port. AUX A and AUX B support:

› HDMI
› Unidirectional coax
› Bidirectional coax
› Fiber
› MADI

› SFP+ (10G) 1

1) USB 3.0 Port 3) AUX A-D Ports 5) Module Slots

2) PSU Connection 4) Retaining Bolt 6) Blade Retaining Screws

1. SFP28 (25G) is not supported.

ULTRIX-MODX-IO

!

BA C D 1 2 3 4

ULTRIX-MOD-SFP

1 2 3 4

ULTRIX-MOD-SFP

1 1OUT IN2 3 2 34 4

ULTRIX-MOD-SDI

1 2 3 4 5

6 6

ULTRIX-MOD-NDI
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 AUX C is reserved for use with the Ultrimix-Dante licensed feature and must be populated with an 
1GE SFP module.

 AUX D is reserved for use with the UltriStream licensed feature and must be populated with an 
1GE SFP module.

The AUX ports can be populated with Small Form-factor Pluggable (SFP) modules from the factory 
or by installing modules in the field. When an AUX port is populated on the ULTRIX-MODX-IO, its 
status is reported in DashBoard and options are provided for mapping and configuring the I/O as 
required. For a list of SFP modules available from Ross Video, refer to the ULTRIX SFP Modules 
Guide. 

4. Retaining Bolt

The retaining bolt is used to secure the blade to the router chassis.

5. Module Slots

Each ULTRIX-MODX-IO accepts up to four modules (e.g. ULTRIX-MOD-NDI, ULTRIX-MOD-SDI, 
ULTRIX-MOD-SFP) enabling you to customize the I/O of the blade as required. Each slot is 
numbered (1-4) with Group 1 as the first slot on the left. This information is also reported in the 
Group column of the Port Configuration interface in DashBoard.

The modules are hot swappable, allowing you to replace any module with the same type or 
another supported type. The DashBoard interface updates automatically to report the new 
module. 

6. Blade Retaining Screws

There is a retaining screw on each end of the blade. These screws help to affix the blade to the 
router chassis. 

Notice — When a module slot within the ULTRIX-MODX-IO blade is not populated with a module, a 
blank plate for the module slot must be installed to ensure proper cooling and ventilation.
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Installing the ULTRIX-MODX-IO
The ULTRIX-MODX-IO blade is installed in a slot of an Ultrix router. The steps required to install a 
blade depends on the router type. This chapter provides two installation methods: one for the 
ULTRIX-NS-FR1, ULTRIX-NS-FR2, and ULTRIX(-NS)-FR5, and the second for installing in the 
ULTRIX-FR12.

If you have questions pertaining to the installation of your ULTRIX-MODX-IO blade, contact us at the 
numbers listed in “Contacting Technical Support”.

Before You Begin
This chapter assumes the following:

• The relevant Ross equipment is installed into a ventilated rack frame. 
• The relative humidity in the environment of the equipment should be <70% (non-condensing). 
• The ambient temperature of the air entering the front panel should not exceed 40°C (104°F), and 

should not fall below 0°C (32°F). 
• It is recommended to leave a 1RU gap between each device.
• When installing more than one ULTRIX-MODX-IO in a router, it is recommended to group the 

blades into consecutive slots.

Static Discharge
Throughout this chapter, please heed the following cautionary note: 

Working with Fiber Optic Connectors
Keep the following in mind if the SFP module(s) installed in a port includes a fiber optic connector:

• Every time you are required to insert a connector into a device or mating sleeve, you must clean 
the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility 
practices of cleaning fiber optic connectors.

• Connectors must always be inserted into a device or have a dust cap on.
• A poor optical connection is often similar to a poor electrical connection. Try removing the 

connector, cleaning, and re-inserting the connector. A bad connection can result in experiencing 
instability of signal, high loss, or a noisy signal.

Verify the Router Software Version
 This section is applicable to all Ultrix router models.

Before installing a new ULTRIX-MODX-IO blade in an existing routing system, the router software 
version must be noted. Your new blade ships with a default firmware installed and must match the 
current version running in the router. This will require contacting Ross Technical Support for the 
appropriate software version (which includes the blade firmware). The router software (and 
corresponding blade firmware) is upgraded through the DashBoard client.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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 There may be newer software versions available than what is currently running on your router. 
The opportunity may be taken at this time to upgrade to a newer software version, however, 
some database editing may be required as features between versions are added.

To verify the software version currently installed on your router
1. Ensure the router has a valid Ethernet connection.

2. Ensure that you are running DashBoard client software version 9.13.0 or higher and that the 
computer running the DashBoard client is located on the same network as the router.

3. Launch DashBoard by double-clicking its icon on your computer desktop.

4. In the Basic Tree View, locate the router you want to verify the software for.

5. Locate the router in the Tree View of DashBoard.

6. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

7. Expand the Ultrix sub-node.

8. Double-click the System Status node to display the tabs in the DashBoard window.

9. Select the Product tab. This tab is located in the series of tabs on the left-side of the DashBoard 
window.

10. Make a note of the value in the System Version field. This is the software version your router is 
currently running. You will need to provide Ross Technical Support this information when you 
contact them.

11. Contact Ross Technical Support for the appropriate software version (which includes the blade 
firmware) for your setup. Refer to “Contacting Technical Support” for contact details.

Installing in an ULTRIX-NS-FR1, ULTRIX-NS-FR2, or ULTRIX(-NS)-FR5
Before installing the ULTRIX-MODX-IO, you must first ensure the required slot is available. This may 
require you to either remove a blank plate or an installed blade from the slot in the rear panel of 
the router. Both methods are outlined in this section.

Removing a Blank Plate from the Ultrix Router Chassis
If you are not replacing an existing blade, you will need to first remove the blank plate from the 
required slot. You will need a #1 Phillips screwdriver to disengage the retaining (captive) screws on 
the plate. While the figures show an ULTRIX-NS-FR1 chassis, the procedure is also applicable to the 
ULTRIX-NS-FR2 and ULTRIX(-NS)-FR5.

 It is recommended to install the ULTRIX-MODX-IO blade in a slot that does not impede access to 
the neighboring blade connectors. 

To remove the blank plate from the router chassis
1. Power down the router and disconnect it from mains power.

2. Use a #1 Phillips screwdriver to disengage the captive retaining screws on either end of the 
blank plate. Refer to Figure 2 for screw locations.

Notice — When a slot within the Ultrix router is not populated with any blade, a blank plate for the slot 
must be installed to ensure proper cooling and ventilation. This is particularly important when you have 
an empty slot above a ULTRIX-MODX-IO blade with high temperature modules (such as an 
ULTRIX-MOD-NDI module). 
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Figure 2  Ultrix Rear Panel — Retaining Screw Locations on the Blank Plate

3. Remove the blank plate from the chassis and set it aside.

Removing a Blade from the Router Chassis
If you are replacing a blade, you must first remove the old blade from the chassis before installing 
the new blade.There are two screws and one bolt that affix the blade to the chassis: a screw on each 
end of the blade and then a Middle Retaining Bolt. You must disengage all three before the blade 
can be removed from the chassis. You will need a 3/16” socket to disengage the bolt (included in the 
kit shipped with your router).  

To remove an existing blade from the router chassis
1. Power down the Ultrix router and disconnect it from mains power.

2. Ensure all cabling is removed from the ports on the I/O Blade.

3. Disengage the retaining screws on either end of the I/O Blade. Refer to Figure 3 for screw 
locations.

We strongly recommend to disengage each screw until its head is approximately 0.25” away from 
the faceplate. Do not fully extract the screws from the chassis. 

Figure 3  Ultrix Rear Panel — Location of Retaining Screws on an ULTRIX-HDBNC-IO Blade

4. From the Ultrix rear panel, unfasten the Middle Retaining Bolt. Note that this bolt is not 
removable but it does extract the blade. Refer to Figure 4 for the bolt location on the rear 
panel.

Figure 4  Ultrix Rear Panel — Location of Middle Retaining Bolt on the Blade

5. Grasp the blade with both hands and gently pull it towards you to remove it from the router 
backplane.

Caution — Steps must be followed in the presented order. Failing to do so can damage the blade.

Caution — Ensure the Middle Retaining Bolt is fully unfastened before attempting to remove the blade 
from the chassis. While the bolt is not removable and serves as a threaded insertion and extraction tool. 
It should be free to move in and out a few millimeters in its socket once unfastened.
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Installing an ULTRIX-MODX-IO Blade into the Router Chassis
The ULTRIX-MODX-IO blade is a complete unit. There are two screws and one bolt that affix the 
blade to the chassis: a screw on each end of the blade and a Middle Retaining Bolt. 

To install an ULTRIX-MODX-IO blade into the router chassis

1. Using the card guides inside the chassis, gently slide the ULTRIX-MODX-IO blade into the chassis 
while lifting up slightly to take the weight.

Figure 5  Sliding the Blade into the Chassis

2. Gently slide the blade in until you feel it start to resist as the edge connectors begin to mate. 
This will occur approximately 1/8” (3mm) before the blade is fully seated. At this stage, the 
Middle Retaining Bolt should be used to pull the blade into its final mated position.

3. Using a 3/16” socket, fully tighten the Middle Retaining Bolt. This bolt secures the blade to the 
chassis from the interior, ensuring proper contacts between the blade and the router 
backplane. 

Figure 6  Ultrix Rear Panel — Location of Middle Retaining Bolt on the Blade

4. Using a Phillips screwdriver, tighten the retaining screws located on the left and right sides of 
the blade. 

 Tightening these screws is required to ensure proper alignment between the blade and the 
router backplane.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit blades in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
blades and related equipment.

Caution — You must first fully tighten the Middle Retaining Bolt before tightening the screws on the 
ULTRIX-MODX-IO. Not doing so will damage the blade, the connectors on the backplane, or both.
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Figure 7  Ultrix Rear Panel — Location of Retaining Screws on the Blade

5. Power on the router as outlined in the ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 Installation 
Guide.

Installing in an ULTRIX-FR12 Chassis
Before installing the ULTRIX-MODX-IO, you must first ensure the required slot is available in the 
ULTRIX-FR12. This may required you to either remove the blank plate or an installed blade from the 
required slot in the rear panel of the router. Both methods are outlined in this section. 

Removing a Blank Plate from the ULTRIX-FR12 Chassis
If you are not replacing an existing blade, you will need to first remove the blank plate from the 
required slot. You will need a #1 Phillips screwdriver to disengage the captive screw.

 It is recommended to install the ULTRIX-MODX-IO in a slot that does not impede access to the 
neighboring blade connectors. 

To remove the blank plate from the ULTRX-FR12 chassis
1. Power down the router and disconnect it from mains power.

2. Disengage the captive retaining screws on either end of the blank plate In Figure 8, the user is 
removing the blank plate in slot 16. 

Notice — The router automatically powers on when power is applied.

Notice — When a blade slot within the ULTRIX-FR12 is not populated with any blade, a blank plate for 
the slot must be installed to ensure proper cooling and ventilation. This is particularly important when you 
have an empty slot above an ULTRIX-MODX-IO blade with high temperature modules (such as an 
ULTRIX-MOD-NDI module). 
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Figure 8  ULTRIX-FR12 Rear Panel — Retaining Screw Locations on a Blank Plate

3. Remove the blank plate from the chassis and set it aside.

Removing a Blade from the ULTRIX-FR12 Chassis
If you are replacing a blade, you must first remove the old blade from the chassis before installing 
the new blade.There are two screws and one bolt that affix the blade to the chassis: a screw on each 
end of the blade and then a Middle Retaining Bolt. You must disengage all three before the blade 
can be removed from the chassis. You will need a 3/16” socket to disengage the bolt (included in the 
kit shipped with your router).  

To remove an existing blade from the ULTRIX-FR12 chassis
1. Power down the ULTRIX-FR12 and disconnect it from mains power.

2. Ensure all cabling is removed from the ports on the I/O Blade.

3. Disengage the retaining screws on either end of the I/O Blade. Refer to Figure 9.

We strongly recommend to disengage each screw until its head is approximately 0.25” away from 
the faceplate. Do not fully extract the screws from the chassis. 

Caution — Steps must be followed in the presented order. Failing to do so can damage the blade.
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Figure 9  ULTRIX-FR12 Rear Panel — Location of Retaining Screws on an ULTRIX-HDX-IO Blade

4. From the ULTRIX-FR12 rear panel, unfasten the Middle Retaining Bolt. Note that this bolt is not 
removable but it does extract the blade. Refer to Figure 9 for the bolt location.

5. Grasp the blade with both hands and gently pull it towards you to remove it from the router 
backplane.

Installing an ULTRIX-MODX-IO Blade into the ULTRIX-FR12 Chassis
The ULTRIX-MODX-IO blade is a complete unit. There are two screws and one bolt that affix the 
blade to the chassis: a screw on each end of the blade and a Middle Retaining Bolt. 

Caution — Ensure the Middle Retaining Bolt is fully unfastened before attempting to remove the blade 
from the chassis. While the bolt is not removable and serves as a threaded insertion and extraction tool. 
It should be free to move in and out a few millimeters in its socket once unfastened.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit blades in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
blades and related equipment.
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To install an ULTRIX-MODX-IO blade into the ULTRIX-FR12 chassis
1. Using the card guides inside the chassis, gently slide the ULTRIX-MODX-IO blade into the chassis 

while lifting up slightly to take the weight.

 Ensure the blade is oriented with the ULTRIX-MODX-IO logo on the bottom (the side nearest to 
the slot silk-screen numbering on the chassis). Refer to the other blades installed in the chassis 
for orientation.

2. Gently slide the blade in until you feel it start to resist as the edge connectors begin to mate. 
This will occur approximately 1/8” (3mm) before the blade is fully seated. At this stage, the 
Middle Retaining Bolt should be used to pull the blade into its final mated position.

3. Using a 3/16” socket, fully tighten the Middle Retaining Bolt. This bolt secures the blade to the 
chassis from the interior, ensuring proper contacts between the blade and the router 
backplane. 

Figure 10  ULTRIX-FR12 Rear Panel — Location of Middle Retaining Bolt on the Blade

4. Using a Phillips screwdriver, fully tighten the screws located on the top and bottom sides of the 
blade. 

Caution — You must first fully tighten the Middle Retaining Bolt before tightening the screws on the 
ULTRIX-MODX-IO. Not doing so will damage the blade, the connectors on the backplane, or both.
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 Tightening these screws is required to ensure proper alignment between the blade and the 
router backplane.

5. Power on the router as outlined in the ULTRIX-FR12 Installation Guide.

Upgrading the Router Software
Upon the initial power up of the router after the hardware upgrade the Alarms table in the 
Hardware Configuration interface in DashBoard may report a “System Error” with a Failed state 
(red indicator), and the Frame Information table in the Hardware Configuration interface reports 
a new Firmware version for the newly upgraded slot. To complete the ULTRIX-MODX-IO blade 
install, you must upgrade the software and clear the alarm states.

Contact Ross Technical Support for the appropriate software version and the blade firmware for 
your setup. Refer to “Contacting Technical Support” for contact details.

Optional Power Connection
This section only applies if your configuration requires that extra power be supplied directly to the 
modules installed in the ULTRIX-MODX-IO blade. 

For More Information on...
• how to contact Ross Technical Support, refer to “Contacting Technical Support”.

Static Discharge
Throughout this chapter, please heed the following cautionary note: 

Connecting the ULTRIX-MODX-IO to a 15V PSU
The ULTRIX-MODX-IO can connect to a power supply that provides regulated +15V DC (5%) @ up to 
4A. The DC Power cord has a locking connector that securely fastens into the power supply DC jack 
on the ULTRIX-MODX-IO blade.    

Notice — The router automatically powers on when power is applied.

Notice — Refer to the Ross Ultrix Configuration Tool on our website, or contact Ross Technical 
Support, for help determining if this power connection is needed for your system.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

Caution — Ensure to connect the DC Power cord of the power supply to the PSU connection on the 
ULTRIX-MODX-IO before connecting the power supply to the power source.

Caution — Use of improper adapters may damage the ULTRIX-MODX-IO and will void the warranty.
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To connect the power cable to the ULTRIX-MODX-IO

1. Connect the female end of the provided power cable into the PSU connection on the 
ULTRIX-MODX-IO blade.

Figure 11  ULTRIX-MODX-IO — PSU Connection

2. Connect the supplied AC power cable into the power module.

3. Connect the supplied power cable’s three-prong male connector to Mains Power.

ULTRIX-MODX-IO

!

BA C D 1 2 3 4

ULTRIX-MOD-SFP

1 2 3 4

ULTRIX-MOD-SFP

1 2 3 4

ULTRIX-MOD-SFP

1 1OUT IN2 3 2 34 4

ULTRIX-MOD-SDI

Note: It is recommended that you always connect the Power Supply Unit to the blade
before connecting to Mains Power.
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Installing a Module
Installing a module into an ULTRIX-MODX-IO blade in an Ultrix router requires you to remove the 
blank plate in the required blade slot, install the required module into the blade, and then install 
the required SFP modules into the required port(s). The procedure for installing a module is the 
same for all module and router types. 

 A single ULTRIX-MODX-IO blade can accommodate up to four modules. 

If you have questions pertaining to the installation of the module, contact us at the numbers listed 
in “Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

Before You Begin
Ensure the ULTRIX-MODX-IO blade is installed in the Ultrix router. Refer to “Installing the 
ULTRIX-MODX-IO” for details.

Required Equipment
The following equipment is required:

• the I/O module to be installed in the ULTRIX-MODX-IO blade
• a #1 Phillips screwdriver

Static Discharge
Throughout this chapter, please heed the following cautionary note: 

Working with Fiber Optic Connectors
Keep the following in mind if the SFP module(s) installed in a port includes a fiber optic connector:

• Every time you are required to insert a connector into a device or mating sleeve, you must clean 
the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility 
practices of cleaning fiber optic connectors.

• Connectors must always be inserted into a device or have a dust cap on.
• A poor optical connection is often similar to a poor electrical connection. Try removing the 

connector, cleaning, and re-inserting the connector. A bad connection can result in experiencing 
instability of signal, high loss, or a noisy signal.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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Installing a Module into the ULTRIX-MODX-IO Blade
When a blade slot is not populated with a module, a blank plate must be installed to protect the 
chassis interior and ensure proper cooling. When installing the module into an unpopulated slot of 
the ULTRIX-MODX-IO blade, you must first remove this blank plate from the slot. 

To remove the blank plate from the ULTRIX-MODX-IO blade slot

1. Locate the blade slot you wish to install the module into.

2. Use a #1 Phillips screwdriver to unfasten each retaining screw from the blank plate.

Figure 12 shows the retaining screws for slot 1. The location of the screws on the blank plate is 
the same for all slots.

Figure 12  ULTRIX-MODX-IO — Location of Retaining Screws for a Slot

3. Remove the blank plate from the blade and set aside.

To install a module into the ULTRIX-MODX-IO blade

1. Grasp the module with both hands.

2. Align the module with the available slot.

3. Gently slide the module into the slot until you feel it start to resist as the edge connectors begin 
to mate. 

4. Using a #1 Phillips screwdriver and the retaining screws, fasten the module to the blade.

 Tightening these screws is required to ensure proper alignment between the module and the 
blade backplane.

Figure 13  ULTRIX-MODX-IO — Location of Retaining Screws on a Module

Replacing a Module
You can hot-swap any module in/out of an ULTRIX-MODX-IO blade. 

 Be aware that when hot swapping an ULTRIX-MOD-NDI, the new ULTRIX-MOD-NDI module will 
have a different MAC Address. This can potentially cause disruptions in the video streams 
previously configured for that module slot (e.g. obtaining a different IP address via DHCP). 
Receivers may need to be manually reconfigured or reapplied to account for this change.

To replace a module

1. In DashBoard, navigate to the ULTRIX-MODX-IO interface as outlined in “To display the IO 
Module interface in DashBoard”.

2. Remove any cables attached to the module.

3. Use a #1 Phillips screwdriver to disengage the retaining screws on either end of the module.

4. Grasp the module with both hands and gently pull it towards you to remove it from the blade.

Notice — When a module slot within the ULTRIX-MODX-IO blade is not populated with a module, a 
blank plate for the module slot must be installed to ensure proper cooling and ventilation.

ULTRIX-MODX-IO
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ULTRIX-MODX-IO

!
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ULTRIX-MOD-SFP
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5. Set the module on a clean, flat, and static-free surface.

6. Install the new module as outlined in “To install a module into the ULTRIX-MODX-IO blade”.

7. Verify that the new module is reported in the ULTRIX-MODX-IO interface in DashBoard.

When a module is installed in a slot of the ULTRIX-MODX-IO blade, the module software may not 
match that of the blade1. There is an option to upgrade only the module software. This upgrade 
will only affect the modules that do not match the blade software. If there is a mismatch between 
the blade software and the module software, refer to “Upgrading the Software”.

Notice — When you remove module from its slot in the ULTRIX-MODX-IO blade, wait a minimum of 5 
seconds to allow the bade to register the empty module slot. Then proceed to install a new module in the 
same slot. Failure to do so could result in improper operation.

1. Not all modules include software.
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Populating the SFP Ports
This chapter provides general instructions on how to populate a port on the ULTRIX-MODX-IO blade 
or an SFP port on the ULTRIX-MOD-SFP module. 

For More Information on...
• installing an SFP module, refer to the documentation that accompanied your SFP module.
• the SFP modules supported by the router, refer to the Ultrix SFP Module User Guide.
• cabling the ports on the ULTRIX-MOD-SFP, refer to “ULTRIX-MOD-SFP”.
• cabling the BNCs on the ULTRIX-MOD-SDI, refer to “ULTRIX-MOD-SDI”.
• cabling the ENET port on the ULTRIX-MOD-NDI, refer to “ULTRIX-MOD-NDI”.

Static Discharge
Throughout this chapter, please heed the following cautionary note: 

Working with Fiber Optic Connectors
Keep the following in mind if the SFP module(s) installed in a port includes a fiber optic connector:

• Every time you are required to insert a connector into a device or mating sleeve, you must clean 
the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility 
practices of cleaning fiber optic connectors.

• Connectors must always be inserted into a device or have a dust cap on.
• A poor optical connection is often similar to a poor electrical connection. Try removing the 

connector, cleaning, and re-inserting the connector. A bad connection can result in experiencing 
instability of signal, high loss, or a noisy signal.

 Refer to the document Important Regulatory and Safety Notices that shipped with your router, 
for safety information when handling fiber optic components.

Populating a Port with an SFP Module
This section provides a general overview of how to install an SFP module into an available port of 
the ULTRIX-MODX-IO blade or ULTRIX-MOD-SFP module. 

Keep the following in mind:

 An SFP module can only be installed in the AUX A or AUX B ports in the ULTRIX-MODX-IO blade. 

 The AUX C port is reserved for the Ultrimix-Dante licensed feature.

 The AUX D port is reserved for use with the UltriStream licensed feature and must be populated 
with an 1GE SFP module.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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To install an SFP module in a port 

1. Remove the dust cap from the port on the ULTRIX-MODX-IO or ULTRIX-MOD-SFP as follows:

a. Locate the port you wish to install the SFP module into.

b. Grasp the cap between your thumb and forefinger and gently press on the sides.

c. Pull the cap towards you and away from the port.

d. Store the dust cap for later use.

2. Locate the markings on the SFP module that identify the orientation for installing. These 
markings may include Tx/Rx icons, or arrows that indicate the signal flow direction.

3. Align the SFP module in front of the empty port.

4. Insert the SFP module into the port, ensuring it is seated home and the latch is engaged.

Caution — Do not remove the dust caps from the port until you are ready to install the SFP module. 

Caution — Do not install an SFP module with fiber-optic cables attached. Doing so can damage the 
cables, the cable connector, the SFP module or all three. 

Caution — Do not remove the dust caps from a SFP module until you are ready to connect the cables. 
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Cabling the AUX Ports
This chapter outlines the cabling designations for the ULTRIX-MODX-IO blade AUX ports when using 
specific licensed features of the Ultrix router. 

For More Information on...
• UltriProc cabling on the ULTRIX-MOD-SDI, refer to “UltriProc Cabling”.
• UltriScape cabling on the ULTRIX-MOD-SFP, refer to “UltriScape Cabling”.

Static Discharge
Throughout this chapter, please heed the following cautionary note: 

Ultrimix-Dante Cabling
The Ultrimix-Dante license provides 64 x 64 input/output audio channels accessible via ethernet on 
the AUX C port of the ULTRIX-HDX-IO and ULTRIX-MODX-IO blades. It utilizes the Audinate® Dante® 
proprietary IP-based audio transport system. 

The Ultrix router identifies the Dante channels as a single pipeline consisting of 64 input and 64 
output channels. Ultrimix-Dante enables the Ultrix router to include Audinate Dante audio inputs 
and outputs into the Ultrix routing matrix. Audio sources from a Dante network can be configured 
as inputs into the Ultrix router. The Ultrix router can also output audio channels to the same Dante 
network.

 The AUX B audio channels are not available for use when Ultrimix-Dante is enabled on a blade. 
AUX B can still be used to route SDI video. Refer to the Ultrix User Guide for details.

Before cabling for Ultrimix-Dante, ensure that the AUX C port on the ULTRIX-MODX-IO blade is 
populated with an 1GE SFP module. (Figure 14)

Figure 14  Ultrimix-Dante Cabling

For More Information on...
• cabling the ULTRIX-HDX-IO blade for Ultrimix-Dante, refer to the Ultrix Installation Guide for 

your router.

UltriStream Cabling
The UltriStream licensed feature provides the ability to encode one NDI stream of a configured 
Ultriscape Multiviewer Head per the AUX D port on an ULTRIX-HDX-IO and ULTRIX-MODX-IO blades. 

Before cabling for UltriStream, ensure that the AUX D port on the ULTRIX-MODX-IO blade is 
populated with an 1GE SFP module. (Figure 15)

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

ULTRIX-MODX-IO
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Ultrimix-Dante
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Figure 15  UltriStream Cabling

 The Multiviewer Head for the video source must be one from the same blade that is transmitting 
the NDI stream. For example, a licensed ULTRIX-MODX-IO blade in Slot 1 cannot send an NDI 
stream of a Multiviewer Head from a licensed ULTRIX-HDX-IO blade in Slot 2.

For More Information on...
• configuring the UltriStream licensed feature, refer to the Ultrix User Guide for your router.
• enabling and configuring the Ultriscape Head(s), refer to the Ultriscape User Guide.
• cabling the ULTRIX-HDX-IO blade for UltriStream, refer to the Ultrix Installation Guide for your 

router.

ULTRIX-MODX-IO
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UltriStream
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ULTRIX-MOD-DPT
This chapter outlines the ULTRIX-MOD-DPT features, cabling designations, DashBoard interfaces, 
and configuration options.

For More Information on...
• installing an ULTRIX-MOD-DPT in the ULTRIX-MODX-IO blade, refer to “Installing a Module”.

Overview
The ULTRIX-MOD-DPT offers flexibility for installations where an SDI or SMPTE-2110 input is not 
available or preferred by providing:

• the ability to drive a range of displays, from local monitors and Multiviewers to large-scale LED 
walls on sets and in stadiums;

• a solution for display processors that require DisplayPort input;
• support for other AV-centric devices, such as AVOIP encoders;
• a single point of efficient status and control via DashBoard.

Features
The following features are standard for the ULTRIX-MOD-DPT module:

• 4 x USB-C ports
• Provides color space conversion:

› YUV 4:2:2 8bit or 10bit
› RGB 4:4:4 8bit or 10bit

• Provides a test pattern source of up to 2160p 60Hz
• A single point of efficient status and control via DashBoard

Supported DisplayPort Video Formats
Table 1 outlines the video formats that the ULTRIX-MOD-DPT supports.

 Ensure that you are using a supported video format. Using unsupported formats may result in 
undefined behavior.

 Interlace video formats are not supported.

Table 1  Supported Video Formats — ULTRIX-MOD-DPT

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

HD

720 P 50

720 P 59.94

720 P 60

1080a P 23.98

1080 P 24
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Hardware Overview
The ULTRIX-MOD-DPT module includes four USB-C ports that are auto-populated. 

Figure 16  Hardware Features of the ULTRIX-MOD-DPT

1. Retaining Screws

There is a retaining screw on each end of the module. These screws affix the module to the 
ULTRIX-MODX-IO blade. Refer to “Installing a Module” for details.

2. USB-C Ports

The ULTRIX-MOD-DPT module includes four USB-C ports that support DisplayPort Alternate 
Mode. A threaded hole is located above each USB-C port that is top-lock screw cable compatible. 

1080 P 25

1080 P 29.97

1080 P  30

3G

1080 P 50

1080 P 59.94

1080 P 60

6G

2160 P 23.98

2160 P 24

2160 P 25

2160 P 29.97

2160 P 30

12G (UHD)

2160 P 50

2160 P 59.94

2160 P 60

a. 1080p Level B and 1080pSF formats are not supported.

1) Retaining Screws 2) USB-C Ports

Table 1  Supported Video Formats — ULTRIX-MOD-DPT (Continued)

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

ULTRIX-MOD-DPT

1 2 3 4

1

2

1
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If required, connect a cable that has a top screw locking mechanism to secure it to the 
ULTRIX-MOD-DPT port.

Each port provides an output up to DisplayPort 1.4. Each port auto detects a sink hot-plug. 

 Audio support is not implemented on the ULTRIX-MOD-DPT. 

Cabling
The ULTRIX-MOD-DPT uses DisplayPort Alternate mode when transmitting to a third-party device. 
This allows the delivery of DisplayPort signals from Ultrix via one of the four available USB Type-C 
ports.

 The USB-C cables must support DisplayPort Alt mode for DP 1.4 for full format functionality.

To achieve optimal video performance:

• Use a DisplayPort cable that is compatible with your video configuration.
• Ensure the cable supports the required DisplayPort version (e.g., DP 1.4).
• Ensure the cable is of an appropriate length to maintain signal integrity. 

 Using an incompatible or excessively long cable may result in reduced video quality or 
connectivity issues.

Supported Sinks
A sink refers to a device or component that receives and processes signals or data from a source. 
For example, in an ULTRIX-MOD-DPT setup, a monitor could act as the sink for video signals sent 
from the ULTRIX-MOD-DPT.

The ULTRIX-MOD-DPT can be used with sinks that support DisplayPort as an input. For example, 
monitors, display encoders for driving display, etc. 

Displaying the ULTRIX-MOD-DPT in DashBoard
The options for configuring the ULTRIX-MOD-DPT are displayed in the Port Configuration interface 
of the router. This interface enables you to configure the color space settings, configure a test 
pattern, and monitor the status of the output signals. (Figure 17)

Notice — Do not use the USB-C ports for non-display purposes (e.g. charging).
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Figure 17  Example of the ULTRIX-MOD-DPT in DashBoard

1. Views Toolbar for ULTRIX-MOD-DPT

Set Views > IO Module > DPT > Outputs to display the ULTRIX-MOD-DPT module(s) in your router. 

2. Slot Map

This area displays a map of the selected ULTRIX-MODX-IO blade as filtered using the Views 
menus. Select the Display Port directly from the required ULTRIX-MOD-DPT module to display its 
settings on the Port Configuration interface.

The color of the port icon on the slot map indicates the following:

› Green — A valid video source signal is detected and a sink is connected.
› Yellow —A sink is connected but a valid video source signal is not detected.
› Red — A sink is not connected.

3. Detected Ports Table

This table lists the available ULTRIX-MOD-DPT ports as determined by the selections made in the 
Views toolbar. This table provides the physical address, video status, and sink status of each 
detected ULTRIX-MOD-DPT port.

Use the list of ports in this table to select the physical address that is to be configured to output a 
DisplayPort signal. 

4. Configuration Options

Select a port from the leftmost table to display its configuration options in the right pane. 

The port labeling follows the same nomenclature as other modules and appears in the Ultrix 
database. Each port is labeled as slotx.MODy-out[z] where x is the physical router slot, y is 
the blade slot that the ULTRIX-MOD-DPT is installed in, and z is the port number. 

The ULTRIX-MOD-DPT settings are organized into six tabs. 

› Card — reports the slot identifier, serial number, and the firmware version for the 
ULTRIX-MODX-IO blade that houses the selected ULTRIX-MOD-DPT. Refer to Table 28 for 
details. 

› Module — reports read-only information on the ULTRIX-MOD-DPT such as serial number, 
firmware version, and temperature. Refer to Table 28 for details.

› Video — provides the video signal configuration options for the ULTRIX-MOD-DPT. Refer to 
Table 30 for details.
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› Port — provides configuration options for the selected port on the ULTRIX-MOD-DPT. Refer to 
“Configuring the Color Space Converter for an Output” and “Configuring a Test Pattern 
Output”.

› Test Pattern — enables you to specify the video format for the internally generated SMPTE 
color bars test pattern for the ULTRIX-MOD-DPT. Refer to “Configuring a Test Pattern 
Output”.

› Status — enables you to monitor the source validity status of each sink connected to the 
ULTRIX-MOD-DPT (e.g. monitors, display drivers). Refer to “Monitoring”.

 Settings that are common to the selected ports, but are assigned different values, are noted with 
an  icon. Refer to “Selecting the Ports to Configure” for more information on this icon.

Displaying the ULTRIX-MOD-DPT in DashBoard
To display the ULTRIX-MOD-DPT settings, you set the Views to IO Module > DPT. 

 You can only configure the outputs on the ULTRIX-MOD-DPT.

To display the ULTRIX-MOD-DPT interfaces in DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the System sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

6. From the Views toolbar:

a. Use the first menu to select IO Module.

b. Use the second menu to select DPT.

c. Use the third menu to select Outputs.
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Routing the ULTRIX-MOD-DPT Outputs
You route the video sources (SRC) to the ULTRIX-MOD-DPT output ports (DEST) through the Ultrix 
routing matrix. Refer to the Ultrix and Ultricore Database User Guide for details.

Configuring the Color Space Converter for an Output
The ULTRIX-MOD-DPT supports color space conversion, which is the process of translating colors 
from one color space to another. Two commonly used color spaces are RGB (Red, Green, Blue) and 
YUV (Luminance, Chrominance). 

• RGB Color Space is widely used in digital displays. In RGB, colors are represented as combinations 
of red, green, and blue light intensities. 

• YUV Color Space is often used in video encoding and compression. YUV separates color 
information into luminance (Y) and chrominance (U and V).

To configure the color space converter for an output

1. Display the ULTRIX-MOD-DPT as outlined in “To display the ULTRIX-MOD-DPT interfaces in 
DashBoard”.

2. From the blade map at the top of the interface, select the DPT port of the ULTRIX-MOD-DPT to 
configure.

3. Select the Port tab.

4. Select an ULTRIX-MOD-DPT port to configure.

In the following example, the user is configuring slot1.MOD1-out[3].

5. Set the Source Select to SDI.

The sourced video to the ULTRIX-MOD-DPT outputs will be SDI video. This will route the 
assigned SDI video source via the Ultrix database to the ULTRIX-MOD-DPT.

6. Use the Color Space menu to assign the color space settings for the video output of a selected 
ULTRIX-MOD-DPT port. Choose from the following:

• RGB 4:4:4 — the red, green, and blue components of the video have the same sampling rate. 
• YUV 4:2:2 — the chrominance (U, V) components are sampled at half the horizontal sample 

rate of the luma (Y) component of the video. This is the default.
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7. Use the Bits Per Plane menu to specify the number of bits per plane for the video output on a 
selected ULTRIX-MOD-DPT port. The default is 10.

8. Select the Max Link Speed for the ULTRIX-MOD-DPT port to use 5400Mbps (HBR2) or 
8100Mbps (HBR3) when connected to a sink device. 

Valid Video Configurations
Depending on the sink’s capabilities some of the video configuration combinations may not be 
valid. The following tables summarize the configuration combinations that will work (shown with a 
check-mark), and which will not due to bandwidth restrictions (shown with ‘N’). 

720p Configurations

1080p Configurations
    

Table 2  Valid Configurations for 720p 50/59.94/60Hz

DP Lane
DP Lane 

Speed    
(Gbps)

DP Max 
Bandwidth 

(Mbps)

720p    
YUV422    

8bits

720p    
YUV422 
10bits

720p           
RGB           
8bits

720p           
RGB         

10bits

4 8.1 25,920    

4 5.4 17,280    

4 2.7 8,640    

2 8.1 12,960    

2 5.4 8,640    

2 2.7 4,320    

Table 3  Valid Configurations for 1080p 23.98/24/25/30Hz

DP Lane
DP Lane 

Speed    
(Gbps)

DP Max 
Bandwidth 

(Mbps)

1080p    
YUV422      

8bits

1080p    
YUV422    
10bits

1080p             
RGB               
8bits

1080p           
RGB            

10bits

4 8.1 25,920    

4 5.4 17,280    

4 2.7 8,640    

2 8.1 12,960    

2 5.4 8,640    

2 2.7 4,320    

Table 4  Valid Configurations for 1080p 50/59.94/60Hz

DP Lane
DP Lane 

Speed    
(Gbps)

DP Max 
Bandwidth 

(Mbps)

1080p50 
YUV422      

8bits

1080p50 
YUV422    
10bits

1080p50      
RGB             
8bits

1080p50      
RGB            

10bits

4 8.1 25,920    

4 5.4 17,280    

4 2.7 8,640    

2 8.1 12,960    

2 5.4 8,640    

2 2.7 4,320    N
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2160p Configurations
  

Configuring a Test Pattern Output
The ULTRIX-MOD-DPT can generate a SMPTE bars test pattern video output without the need of a 
source. This can be useful for quick testing/verifying of a sink device or setup. 

To configure a test pattern output

1. Display the ULTRIX-MOD-DPT as outlined in “To display the ULTRIX-MOD-DPT interfaces in 
DashBoard”.

2. Select the Port tab.

3. Select an ULTRIX-MOD-DPT port to configure.

4. Set the Source Select to Test Pattern.

This assigns the internal generated test pattern as the sourced video for the selected port on 
the ULTRIX-MOD-DPT. 

In the following example, the user is configuring slot1.MOD1-out[2]

Table 5  Valid Configurations for 2160p 23.98/24/25/29.97/30Hz

DP Lane
DP Lane 

Speed    
(Gbps)

DP Max 
Bandwidth 

(Mbps)

2160p24 
YUV422    

8bits

2160p24 
YUV422 
10bits

2160p24    
RGB           
8bits

2160p24    
RGB         

10bits

4 8.1 25,920    

4 5.4 17,280    

4 2.7 8,640    N

2 8.1 12,960    

2 5.4 8,640    N

2 2.7 4,320 N N N N

Table 6  Valid Configurations for 2160p 50/59.94/60Hz

DP Lane
DP Lane 

Speed    
(Gbps)

DP Max 
Bandwidth 

(Mbps)

2160p50 
YUV422    

8bits

2160p50 
YUV422 
10bits

2160p50    
RGB           
8bits

2160p50    
RGB         

10bits

4 8.1 25,920    

4 5.4 17,280    N

4 2.7 8,640 N N N N

2 8.1 12,960   N N

2 5.4 8,640 N N N N

2 2.7 4,320 N N N N
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5. Use the Color Space menu to assign the color space settings for the video output of the test 
pattern. Choose from the following:

• RGB 4:4:4 — the red, green, and blue components of the video have the same sampling rate. 
• YUV 4:2:2 — the chrominance (U, V) components are sampled at half the horizontal sample 

rate of the luma (Y) component of the video. This is the default.

6. Use the Bits Per Plane menu to specify the number of bits per plane for the test pattern output 
on the selected ULTRIX-MOD-DPT port. The default is 10.

7. Use the Max Link Speed menu to set the maximum link rate of the test pattern output on the 
selected ULTRIX-MOD-DPT port. Choose from the following:

• 5400Mbps— the estimated bandwidth (transfer rate of data) between the ULTRIX-MOD-DPT 
and a sink device will be no more than 5.4Gbps. This is the default.

• 8100Mbps — the estimated bandwidth (transfer rate of data) between the ULTRIX-MOD-DPT 
and a sink device will be no more than 8.1Gbps.

8. Select the Test Pattern tab.

9. Use the Test Pattern Format menu to specify the resolution and frame rate for the test pattern 
output.
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 The Test Pattern Format setting applies to all ports that have their Source Select set to Test 
Pattern on the same ULTRIX-MOD-DPT module. 

Monitoring
The ULTRIX-MOD-DPT > Status tab enables you to monitor the EDID, Sink Detection Status, Sink Link 
Train, and number of lanes for the port.

Figure 18  Example of the ULTRIX-MOD-DPT > Status Tab

Status Reporting
The ULTRIX-MOD-DPT also reports the following issues:

• Sink Plug Status (per-port) — Reports “Connected” when a valid sink is connected to the 
ULTRIX-MOD-DPT. Reports “Not Connected” when no sink or an invalid sink is detected (e.g. a 
cellphone charger). 

• Bandwidth Exceeded (per-port) — See “Valid Video Configurations” for more information. This 
alarm is reported in the Status tab.

• Link Training Failed (per-port) — Link training is the process of establishing a reliable 
communication channel between the ULTRIX-MOD-DPT and the sink (e.g. a monitor). This issue is 
reported in the Ultrix Alarms tab (Systems > Configuration > Ultrix).

• Invalid Format (per-port) — Detects unsupported frame rates or resolution.

 The ULTRIX-MOD-DPT does not support interlace video formats.

EDID Reporting
EDID (Extended Display Identification Data) is metadata sent by a display (a monitor) to a source 
device (ULTRIX-MOD-DPT) over DisplayPort, HDMI, or other connections. It includes information 
about supported resolutions, refresh rates, color depth, audio formats, and other specifications. 
This data allows the source device to adjust its output for optimal display settings, enabling 
plug-and-play compatibility between devices.

The ULTRIX-MOD-DPT displays the raw 128bit EDID hex values read from the connected sink in the 
Status > EDID field. These hex values can be decoded using an EDID parsing tool.
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Upgrading the ULTRIX-MOD-DPT Software
The ULTRIX-MOD-DPT can be upgraded in the same manner as any module for the 
ULTRIX-MODX-IO blade. You can choose to upgrade a specific ULTRIX-MOD-DPT, or all the 
ULTRIX-MOD-DPT modules in a single blade.

For More Information on...
• upgrading the ULTRIX-MOD-DPT software, refer to “Upgrading the Software”.

Keep the following in mind:

• Ensure the Enable Upgrades & Support Access box is selected in the Ultrix > System > 
Configuration > Connections > Services tab. 

• The ULTRIX-MOD-DPT *.bin file is uploaded to each module in a blade serially. Each module takes 
approximately 2.5 minutes to upgrade. A fully loaded blade could take up to 12 minutes to 
upgrade all modules. 

• In the case where the ULTRIX-MOD-DPT module is plugged into a blade and the module software 
does not match that of the blade, there is the option to do a module-level-only upgrade. This 
upgrade will only affect the modules that do not match the blade software. Options for this 
feature appear in the Ultrix > Port Configuration > IO Module View > Module tab. The user will 
need to select “Begin Upgrades” to update the module(s). 

 If a new ULTRIX-MODX-IO blade with different software is plugged into a router slot, the modules 
in that new blade would upgrade to whatever software version is on that blade. This could lead to 
different module upgrade behaviors on blades in the same frame. In this scenario, it is 
recommended to go through the full Standard Remote Upgrade procedure again. 

DashBoard Menus
This section briefly outlines the tabs that display when the Port Configuration > Views is set to IO 
Module > DPT > Outputs for an ULTRIX-MODX-IO populated with at least one ULTRIX-MOD-DPT.

For More Information on...
• the Card tab, refer to Table 28
• the Module tab, refer to Table 28.
• the Video tab, refer to Table 25.

Port Tab
The Port tab provides controls to define the video output(s) of an ULTRIX-MOD-DPT.

Notice — The ULTRIX-MOD-DPT can be hot plugged in/out of the ULTRIX-MODX-IO blade. When a 
module is unplugged from the blade, wait until the DashBoard interface reports that the module is no 
longer installed (typically about 5 seconds). You may then plug in a new module into the available slot. 
Failure to do so could result in improper operation.
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Figure 19  Example of the Port Tab

Table 7 summarizes the options on the Port tab.

 
Table 7  Port Configuration — Views > ULTRIX-MOD-DPT > Port Tab

Item Parameters Description
Source Select SDI Assigns SDI video as the source for a specific 

ULTRIX-MOD-DPT port. Refer to the Ultrix and Ultricore 
Database User Guide for details on assigning sources to 
destinations in your routing system.

Test Pattern A SMPTE bars test pattern replaces all of the output 
picture (but not the HANC and VANC) for a specific 
ULTRIX-MOD-DPT port.

Color Space RGB 4:4:4 Converts the source video to RGB 4:4:4 

YUV 4:2:2 Converts the source video to YUV 4:2:2. This is the 
default.

Bits Per Plane 8 Specifies the number of bits per plane for the video being 
output. The default is 10.10

Max Link Speed 5400 Mbps The estimated bandwidth (transfer rate of data) between 
the ULTRIX-MOD-DPT and a sink device will be no more 
than 5.4Gbps (HBR2). This is the default.

8100 Mbps The estimated bandwidth (transfer rate of data) between 
the ULTRIX-MOD-DPT and a sink device will be no more 
than 8.1Gbps (HBR3)

Reset Port Enables the user to reset the connection to the sink device connected to the 
selected ULTRIX-MOD-DPT port. Once this button is clicked, there is a disconnect, 
then a pause of 15sec. A sequence of actions is performed to re-initiate the link 
training to that sink device. 
Some sink devices are sensitive and may encounter issues that require a 
plug/unplug cycle to resolve. The Reset Port allows for some issues to be resolved 
remotely via DashBoard without having to physically unplug/plug the connection.
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Test Pattern Tab
When the ULTRIX-MOD-DPT Port > Source Select is set to Test Pattern, use the Test Pattern tab to 
determine the video format of the SMPTE bars test pattern.

Figure 20  Example of the Test Pattern Tab

Table 8 summarizes the options on the Test Pattern tab. 

Status Tab
The Status tab provides read-only fields that report video related status (such as format), and sink 
connection status.

Table 8  Port Configuration — Views > ULTRIX-MOD-DPT > Test Pattern Tab

Item Parameters Description
Test Pattern 
Formata

a. This setting applies to all ports with the Source Select set to Test Pattern on a selected ULTRIX-MOD-DPT.

1080p60 Specifies the video format of the SMPTE bars test 
pattern1080p30

720p60

2160p60
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Figure 21  Example of the Status Tab

Table 9 summarizes the read-only information reported on the Status tab. 

Table 9  Port Configuration — Views > ULTRIX-MOD-DPT > Status Tab

Item Parameters Description
Sink Plug Status Connected (Green) The ULTRIX-MOD-DPT port is connected to a valid 

DisplayPort-supported sink

Not Connected (Red) The ULTRIX-MOD-DPT port is not connected to a 
sink device

Bandwidth 
Status

OK (Green) Indicates the current port settings are within the 
link training bandwidth

Exceeded (Red) Indicates the current port settings exceed the link 
training bandwidth. 
Verify the color space type, bits per plane value, 
and/or the quality of the signal routed to this port.

N/A (Grey) A connection to a sink device is not detected

Format Status OK (Green) The video format of the signal routed to this port is 
supported

Invalid The routed video is not of a supported format

N/A (Grey) A connection to a sink device is not detected

Lane Count # Reports the number of data lanes currently being 
used for transmitting video between the 
ULTRIX-MOD-DPT and the sink (a monitor). 
DisplayPort can use multiple lanes (typically 1, 2, or 
4) to increase bandwidth and support higher 
resolutions and refresh rates. 

N/A (Grey) A connection to a sink device is not detected
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Link Rate # Reports the speed at which data is transmitted over 
each lane of the connection. 
Higher link rates allow for greater bandwidth, 
enabling support for higher resolutions, refresh 
rates, and color depths. For example, DisplayPort 
1.4 supports link rates up to 8.1Gbps per lane, while 
DisplayPort 1.2 can go up to 5.4Gbps per lane.

N/A (Grey) A connection to a sink device is not detected

EDID Data <text> Displays the raw 128-bit EDID hex values read from 
the connected sink

N/A (Grey) A connection to a sink device is not detected

Table 9  Port Configuration — Views > ULTRIX-MOD-DPT > Status Tab (Continued)

Item Parameters Description
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ULTRIX-MOD-NDI
This chapter summarizes the ULTRIX-MOD-NDI features, cabling requirements, and configuration. 

For More Information on...
• installing an ULTRIX-MOD-NDI in the ULTRIX-MODX-IO blade, refer to “Installing a Module”.
• upgrading the ULTRIX-MOD-NDI software, refer to “Upgrading the Software”.

Overview
An ULTRIX-MOD-NDI module can be installed in any slot of the ULTRIX-MODX-IO blade. Each 
module supports up to 4 bidirectional HD (1080p1) NDI streams going directly to/from the Ultrix 
router. The video source for an NDI sender is determined by the Ultrix router (the SDI source that is 
routed to the destination provided by the ULTRIX-MOD-NDI). Each SDI source is decoded from NDI 
streams on the network and the SDI destinations are encoded to NDI streams that will go on the 
network.

Operation Mode
The number of NDI streams that an ULTRIX-MOD-NDI can manage depends on the Operation mode 
setting. There are two modes:

• 4in, 4out — supports 4 NDI sender streams and 4 NDI receiver streams up to 1080p 60Hz with a 
maximum of 2 channels of audio per stream (TCP transport mode only). This is the default.

• 2in, 2out — supports 2 NDI sender streams and 2 NDI receiver streams up to 1080p 60Hz with up 
to 8 channels of audio per stream (TCP, rUDP, UDP transport modes).

NDI Decoder
The ULTRIX-MOD-NDI can decode SDI video up to 1080p60 YUV422 received from one NDI stream 
on the network. Each received NDI stream is mapped as an SDI source in the Ultrix database. From 
the DashBoard interface you can monitor the decode stream state, and video format. The stream 
type is fixed to NDI High Bandwidth (NDI-HB).

NDI Encoder
The ULTRIX-MOD-NDI can encode SDI video up to 1080p60 YUV422. This enables you to send up to 
4 NDI streams of SDI video up to 1080p 60Hz using NDI High Bandwidth (SpeedHQ2 Codec) to the 
network. From the DashBoard interface you can monitor the encode stream state, and video 
format. The stream type is fixed to NDI High Bandwidth (NDI-HB).

Audio Streaming
As of the v6.7 software, each available NDI video decoder and encoder (as defined by the Operation 
mode) can be accompanied by an associated audio stream. An audio stream is encapsulated in its 
associated video stream with a device alias, stream name, and group.

 Audio-only NDI streams are not supported at this time.

The sample rate for all audio NDI streams (both sender and receiver) is 48kHz. On the decoder, the 
ULTRIX-MOD-NDI will attempt to perform sample rate conversion (SRC) to 48kHz for sources that 
have other sample rates.

1. 1080p Level B and 1080pSF formats are not supported.
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Features
Each ULTRIX-MOD-NDI module provides:

• 1x GigE RJ45 copper connector

• a maximum of 4+4 NDI High Bandwidth streams up to 1080p 60Hz1

› SpeedHQ2 (8bit 4:2:2) Codec
› Full bandwidth I-frame compression

• Selectable transport / receive Unicast Transport (rUDP, UDP, Multi-TCP, TCP)
• Stream discovery via:

› mDNS
› Group filtering
› Discovery Server

• Audio support (Operation mode dependent)
› 4in, 4out mode — a maximum of 2 channels of audio per stream (TCP transport mode only)
› 2in, 2out — a maximum of 8 channels of audio per stream (TCP, rUDP, UDP transport modes)

• Hot-swappable capability

Supported Video Formats
Table 10 outlines the video formats that the ULTRIX-MOD-NDI supports.

 Ensure that you are using a supported video format. Using unsupported formats may result in 
undefined behavior.

1. 1080p Level B and 1080pSF formats are not supported.

Table 10  Supported Video Formats — ULTRIX-MOD-NDI

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

HD

720 P 50

720 P 59.94

720 P 60

1080 I 50

1080 I 59.94

1080 I 60

1080a P 23.98

1080 P 24

1080 P 25

1080 P 29.97

1080 P  30

3G

1080 P 50
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Hardware Overview
The ULTRIX-MOD-NDI module includes one ENET port that is auto-populated.

Figure 22  Hardware Features of the ULTRIX-MOD-NDI

1. Retaining Screws

There is a retaining screw on each end of the module. These screws affix the module to the blade. 

2. ENET Port

One 1GbE RJ45 port that supports 4+4 full bandwidth streams, allowing you to integrate NDI 
devices into a primarily SDI or SMPTE ST-2110 facility. Table 11 provides information on the ENET 
LED behavior. 

Cabling
The primary function of the ENET port is to provide a 1GbE network interface that can be configured 
to send and/or receive NDI video in DashBoard. The exact steps for connecting your 
ULTRIX-MOD-NDI to your facility via ethernet depend on the network requirements of your facility.

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP address, subnet mask, and 
default gateway for your ULTRIX-MOD-NDI.

 If difficulties or problems are experienced when connecting the ULTRIX-MOD-NDI to a network 
hub, contact your network administrator.

1080 P 59.94

1080 P 60

a. 1080p Level B and 1080pSF formats are not supported.

1) Retaining Screws 2) ENET Port

Table 11  ULTRIX-MOD-NDI — LED Descriptions
LED Color Description

Flashing Yellow The ULTRIX-MOD-NDI has booted and the link is up

Yellow The ULTRIX-MOD-NDI has booted but the link is not up

Red The ULTRIX-MOD-NDI has not booted correctly

Off The ULTRIX-MOD-NDI is not powered

Table 10  Supported Video Formats — ULTRIX-MOD-NDI (Continued)

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

ENET

ULTRIX-MOD-NDI1

2

1
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Displaying the ULTRIX-MOD-NDI in DashBoard
The options for configuring the ULTRIX-MOD-NDI are displayed in the Device Configuration 
interface of the router. This interface enables you to assign the network settings, specify access to 
the NDI streams, and monitor the communication status of the streams. (Figure 23)

Figure 23  Example of the ULTRIX-MOD-NDI Configuration Options in DashBoard

1. Views Toolbar for ULTRIX-MOD-NDI

Use the Views > IO Module options to select between Input and Output (Decoder and Encoder) 
This determines what entries are displayed in the Detected NDI Streams table (the left pane of 
the interface). Figure 23 displays the Views > IO Module > NDI > Outputs interface.

2. Slot Map

This area displays a map of the selected ULTRIX-MODX-IO blade as filtered using the Views 
menus. The ULTRIX-MOD-NDI ENET icon on the slot map reports an amalgamated signal status 
by color. The icon color is a combination of the Link, SDI Video, SDI Audio, Tx/Rx Stream status 
fields. Table 12 provides information on the ENET color and associated status. 

3. Detected NDI Streams Table

This table lists the available NDI streams as determined by the selections made in the Views 
toolbar and the NDI Access settings. This table provides the Physical Address, SDI Video status, 

Table 12  ULTRIX-MOD-NDI — ENET Icon in DashBoard
Icon Color Description

Green • The link is connected/up
• All encoders/decoders are configured and running successfully
• There is valid SDI on all module inputs/outputs

Yellow • The link is connected/up
• Some encoders/decoders have errors and/or a SDI signal is not 

detected

Red One of the following is occurring:
• The link is down/physically unplugged; or
• All configured encoders/decoders have errors and there is no 

SDI video routed
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SDI Audio status, and Tx/Rx Stream status (a summary of the full status of the stream with a color 
indicator for state, and the stream name without the device alias).

Use the list of ports in this table to select the physical address that is to be configured to 
send/receive an NDI stream. 

4. Configuration Options

Select an NDI stream from the Detected NDI Streams table to display its configuration options in 
the right pane. There are sub-tabs for Network, NDI Access (Discovery and Global NDI Stream 
settings) and NDI Stream (Sender/Receiver configuration based on the selected Views > I/O 
Module options).

Sources and Destinations follow the same nomenclature as other modules and appear in the 
Ultrix database. A source is labeled as: slotx.MODy-in[z], and a destination is labeled as 
slotx.MODy-out[z] where x is the physical router slot, y is the blade slot that the 
ULTRIX-MOD-NDI is installed in, and z is the SDI port number. 

The ULTRIX-MOD-NDI settings are organized into seven tabs. The following five ULTRIX-MOD-NDI 
tabs are the same, regardless of whether the Views is set to Inputs or Outputs:

› Card — reports additional read-only information. Refer to Table 28 for details.
› Module — reports read-only information on the ULTRIX-MOD-NDI such as serial number, 

firmware version, and temperature. Refer to Table 28 for details.
› Operation Mode — determines the number of decoders and encoders for this specific 

ULTRIX-MOD-NDI. Refer to “Specifying an Operation Mode”.
› Network — enables you to assign the network settings for the ENET port on the 

ULTRIX-MOD-NDI. 
› NDI Access — enables you to configure the global settings for all NDI streams of the 

ULTRIX-MOD-NDI. 

The remaining two tabs have different settings depending on whether you are viewing Inputs 
(Decoders) or Outputs (Encoders):

› Video — reports the SDI fields for the ULTRIX-MOD-NDI (provides the relevant settings as the 
Views > Baseband > SDI interface). Refer to Table 29 for details on the SDI input settings, and 
Table 30 for details on the SDI output settings.

› NDI Stream — enables you to define the decoders and/or encoders for the ULTRIX-MOD-NDI.

 Settings that are common to the selected ports, but are assigned different values, are noted with 
an  icon. Refer to “Selecting the Ports to Configure” for more information on this icon.

Displaying the ULTRIX-MOD-NDI in DashBoard
To display the ULTRIX-MOD-NDI settings, you set the Views to IO Module > NDI and select between 
Inputs (Decoders) and Outputs (Encoders). 

To display the ULTRIX-MOD-NDI interfaces in DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the System sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

6. From the Views toolbar:
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a. Use the first menu to select IO Module.

b. Use the second menu to select NDI.

7. To view the Decoder settings, set the third menu to Inputs.

8. To view the Encoder settings, set the third menu to Outputs.

Configure the Global Network Settings
This section outlines the method for assigning the network settings for the ENET port on the 
ULTRIX-MOD-NDI. A unique IP address must be assigned to each ULTRIX-MOD-NDI installed in the 
blade. This step is required before streams can be sent and/or received by the ULTRIX-MOD-NDI. 

To configure the network settings for the ULTRIX-MOD-NDI

1. Display the ULTRIX-MOD-NDI as outlined in “To display the ULTRIX-MOD-NDI interfaces in 
DashBoard”.

2. From the Detected NDI Streams Table on the left, select any port on the ULTRIX-MOD-NDI of 
which you want to configure network settings.
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 The Network settings are global to the module (any of the 4 ports can be selected).

3. Select the Network tab.

In the following example, the user is configuring the ENET port of the first ULTRIX-MOD-NDI.

4. To manually configure the network settings:

a. Set the Mode to Static.

b. Use the IP address field to specify the static IP address. This is the IP address that is used to 
communicate with the ULTRIX-MOD-NDI.

c. Use the Subnet mask field to specify the subnet mask for the ULTRIX-MOD-NDI. 

d. Use the Default gateway field to specify the gateway for communications outside of the 
local area network (LAN) the ULTRIX-MOD-NDI will use.

5. If you want the network settings for the ULTRIX-MOD-NDI to be automatically obtained, and 
DHCP service is available on your control network, set the Mode to DHCP.

6. Click Apply (located in the bottom right corner).

Configuring the Global Settings for NDI Access
This section outlines how to configure the global settings for all NDI streams and is applicable to 
decoders and encoders of the ULTRIX-MOD-NDI.

To set the global NDI Access settings for the ULTRIX-MOD-NDI

1. Display the ULTRIX-MOD-NDI interface as outlined in “To display the ULTRIX-MOD-NDI 
interfaces in DashBoard”.

2. From the Detected NDI Streams Table on the left, select any port on the ULTRIX-MOD-NDI of 
which you want to configure the NDI Access settings.

 The NDI Access settings are global to the module.

3. Select the NDI Access tab.

4. Use the Receive Group(s) field to specify the groups on your network.

By default, the Receive Group(s) field is populated by the group “Public”. Group filtering can 
be used to view a subset of streams on a network with many NDI streams available. All desired 
groups should be entered in this field, separated by commas (e.g. Public,Group1).
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5. Use the NDI Discovered Sources table to view all the discovered NDI streams from the 
specified groups on your network. 

 The streams listed in the NDI Discovered Sources table are defined by the entries in the Receive 
Group(s) field.

To use an NDI Discovery Server to discover the NDI streams (optional)

 Enabling this feature and pointing to the correct IP address will result in all newly created NDI 
encoder streams from this ULTRIX-MOD-NDI to be registered on the discovery server. The 
ULTRIX-MOD-NDI will also discover all streams that are registered on the discovery server and 
subscribe to them for configuring an NDI decoder.

1. Locate the Global Stream Settings area.

2. Use the Discovery Server IP(s) field to specify the IP address range. 

Multiple IP addresses can be used by separating with a comma (e.g. 127.0.0.1,10.0.0.1,10.0.0.2).

3. Select the Enable box.

Specifying an Operation Mode
Before proceeding to configure your ULTRIX-MOD-NDI, you must first specify the Operation mode 
for each module in the ULTRIX-MODX-IO blade. This will determine the number of available 
decoders/encoders. 

When switching modes, all active NDI streams on the ULTRIX-MOD-NDI will be stopped and 
settings that are not compatible in the mode are reverted to the default.

To specify the operation mode

1. Display the ULTRIX-MOD-NDI interface as outlined in “To display the ULTRIX-MOD-NDI 
interfaces in DashBoard”.

2. From the Detected NDI Streams Table on the left, select any port on the ULTRIX-MOD-NDI of 
which you want to configure the Operation mode.

 The Operation mode is global to the module.
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3. Select the Operation Mode tab.

4. Select one of the following:

• 4in, 4out — supports 4 NDI decoder streams and 4 NDI encoder streams up to 1080p 60Hz 
with a maximum of 2 channels of audio per stream (TCP transport mode only). This is the 
default.

• 2in, 2out — supports 2 NDI decoder streams and 2 NDI encoder streams up to 1080p 60Hz 
with up to 8 channels of audio per stream (TCP, rUDP, UDP transport modes).

5. Click Apply.

A Confirmation dialog opens.

6. Click OK.

The Confirmation dialog closes and the new mode is applied.

Configuring an NDI Decoder
NDI Decoders are the input path to the Ultrix router. An NDI stream from the network is converted 
into SDI video to the router.

 The number of NDI streams that an ULTRIX-MOD-NDI can decode depends on the Operation 
mode. Refer to “Specifying an Operation Mode” for details.

Video Decoding
By default, the ULTRIX-MOD-NDI uses mDNS to register sources with other NDI devices on the 
network. This section outlines how to configure the decoder for an ULTRIX-MOD-NDI using the 
options in the Port Configuration interface in DashBoard. 

When the UltriSync licensed feature is enabled on the ULTRIX-MODX-IO inputs, it will synchronize 
the incoming NDI decoder streams from the network to the frame video reference. Refer to the 
Ultrix User Guide for your router to learn more about the supported frame reference and video 
format combinations.

To configure a decoder for video streaming

1. Display the ULTRIX-MOD-NDI interface as outlined in “To display the ULTRIX-MOD-NDI 
interfaces in DashBoard”.

2. To view the receiver streams, select Inputs from the Views toolbar.
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Use this view to configure the decoder of a selected ULTRIX-MOD-NDI.

3. From the Available Ports table in the left pane, select the destination SDI port where the NDI 
stream will be decoded.

4. Select the NDI Stream tab.

In the following example, the user is configuring slot1.MOD1-in[1].

5. Use the Stream Name field to select the stream to receive for decoding. 

The available streams in the Stream Name field are determined by the NDI Access settings. 
Undiscovered streams can also be manually subscribed to by typing the stream name into this 
field, using the format: [NDI Device Alias] ([Stream Name]).

6. If required, use the Receive Mode to specify the transport protocol. 

 It is highly recommended to keep the Receive mode set to the default setting of Auto (Unicast).

7. Select the Receiver Configuration > Enable box.

8. Click Apply.

Audio Decoding
Each received NDI stream will be outputted as embedded audio in the SDI signal into the Ultrix 
router. This enables the audio to be routed as a source in the Ultrix.

 Audio streams must be accompanied by an associated video stream. 

The ULTRIX-MOD-NDI will always supply a 16-channel audio signal embedded in the SDI video to 
the Ultrix router regardless of the channel count of the source NDI stream. The number of received 
audio channels is dependent on the Operation mode. 

• In 4in, 4out mode, the maximum number of channels receivable is 2 channels.
• In 2in, 2out mode, the maximum number of channels receivable is 8 channels.
• For streams with channel counts lower than the maximum number of channels receivable, silence 

is applied to the inactive channels. 
• For streams with channel counts higher than the maximum number of channels receivable, the 

ULTRIX-MOD-NDI will drop the higher order channels.
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To configure a decoder for audio streaming

1. From the Available Ports table in the left pane, select the destination SDI port where the NDI 
stream will be decoded.

2. Select the NDI Stream tab.

3. Select the Enable Audio box.

4. Click Apply.

Configuring an NDI Encoder
NDI Encoders are the output path from the Ultrix router. The SDI video from the router is converted 
to an NDI stream that goes on the network. 

 The number of NDI streams that an ULTRIX-MOD-NDI can encode depends on the Operation 
mode. Refer to “Specifying an Operation Mode” for details.

Video Encoding
This section outlines how to configure a video encoder for an ULTRIX-MOD-NDI module. 

 If the UltriScape licensed feature is enabled on the MOD1-1, MOD2-1, and/or MOD4-1 outputs of 
the blade, this has the effect of configuring those NDI encoder streams into a Multiviewer.

To configure an encoder for video streaming

1. Display the IO Module interface as outlined in “To display the ULTRIX-MOD-NDI interfaces in 
DashBoard”.

2. Select Outputs from the Views toolbar.

Use this view to configure the encoder of a selected ULTRIX-MOD-NDI.

3. From the Available Ports table in the left table, select the SDI source to encode into an NDI 
stream and output it onto the network.

4. Select the NDI Stream tab.

5. Select the Sender Configuration > Enable box.

6. Use the NDI Device Alias field to specify a unique identifier for this stream. This name is used 
to identify the streams the ULTRIX-MOD-NDI is encoding.
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7. Use the Stream Name field to assign a name to the stream and identify it on the network. 

The stream is reported as “<NDI Device Alias> (<Stream Name>)” when advertised on the 
network.

8. Use the Group(s) field to identify the NDI Sender Group name for the ULTRIX-MOD-NDI stream 
output. 

9. If required, use the Transport Mode menu to specify the transport protocol for encoding on 
this ULTRIX-MOD-NDI. 

 It is highly recommended to keep the Transport Mode set to the default setting of Auto (Unicast).

10. Click Apply.

Audio Encoding
The NDI sender stream will use the audio source as determined by the Ultrix router (the SDI source 
that is routed to the audio output(s) provided by the ULTRIX-MOD-NDI). 

To configure an encoder for audio streaming

1. From the Available Ports table in the left pane, select the destination SDI port where the NDI 
stream will be decoded.

2. Select the NDI Stream tab.

3. Select the Enable Audio box.

4. If the Operation mode is set to 4in, 4out, the Channel Count field is fixed to 2.

5. If the Operation mode is set to 2in, 2out, use the Channel Count field to specify the maximum 
number of audio channels sent by this NDI encoder. You can choose from 2, 4, or 8 channels.

While an SDI signal provides up to 16 channels of audio, the ULTRIX-MOD-NDI will only send the 
first n channels of audio in the order received from the SDI signal (where n is the Channel Count 
value). For example, if the Channel Count is 4, the ULTRIX-MOD-NDI will encode audio channels 
1-4 only. 

6. Click Apply.

DashBoard Menus
This section briefly outlines the interfaces that only display for the ULTRIX-MOD-NDI. 

For More Information on...
• the Device Configuration interfaces in DashBoard, refer to “Using the Device Configuration 

Interface”.

Operation Mode Tab
The Operation Mode tab enables you to specify how many inputs and outputs for a selected 
ULTRIX-MOD-NDI. This feature also determines the number of available audio channels to stream.



ULTRIX-MODX-IO User Guide (v3-rev7) ULTRIX-MOD-NDI • 63

Figure 24  Example of the Views > IO Module > NDI > Operation Mode Tab

Table 13 summarizes the options displayed in the IO Module > NDI > Operation Mode tab. 

Network Tab
The Network tab provides options for configuring the ULTRIX-MOD-NDI network settings to send 
and/or receive the NDI streams via the ENET port on the ULTRIX-MOD-NDI.

 The Network tab provides the global settings for the ULTRIX-MOD-NDI and applies to both the 
encoders and decoders.

Table 13  Port Configuration — Views > IO Module > NDI > Operation Mode

Item Parameters Description
Current Operation 
Mode is:

4in, 4out Supports 4 NDI sender streams and 4 NDI 
receiver streams up to 1080p 60Hz with a 
maximum of 2 channels of audio per 
stream (TCP transport modes only). This is 
the default.

2in, 2out Supports 2 NDI sender streams and 2 NDI 
receiver streams up to 1080p 60Hz with up 
to 8 channels of audio per stream (TCP, 
rUDP, UDP transport modes).
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Figure 25  Example of the Views > IO Module > NDI > Network Tab

Table 14 summarizes the options displayed in the IO Module > NDI > Network tab. 

Table 14  Port Configuration — Views > IO Module > NDI > Network

Item Parameters Description
Mode Static The user manually assigns the network 

settings for the ULTRIX-MOD-NDI

DHCP Automates the assignment of the network 
settings for the ULTRIX-MOD-NDI. This is 
the default.

IP Address # Assigns the IP address to the 
ULTRIX-MOD-NDI. This address is used to 
communicate with devices on your 
streaming network.

Subnet Mask # Specifies the subnet mask for the 
ULTRIX-MOD-NDI

Default Gateway # Specifies the gateway for communications 
outside of the local area network (LAN)

Link Status 
(read-only)

Up (Green) The link for the ULTRIX-MOD-NDI ENET port 
is valid

Down (Red) The link for the ULTRIX-MOD-NDI ENET port 
is invalid (fails)

MAC Address 
(read-only)

# Indicates the unique MAC Address currently 
assigned to the ENET port of the 
ULTRIX-MOD-NDI

Tx Bandwidth 
(Mbps)

# Reports the bandwidth utilization (to the 
nearest 100Mbps) sent from the processor 
to the network links on the specified 
ULTRIX-MOD-NDI ENET port
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NDI Access Tab
The NDI Access tab provides options for determining the NDI streams received/sent via the ENET 
port on the ULTRIX-MOD-NDI. The NDI Access tab is organized into two areas: NDI Discovery and 
Global Stream Settings. (Figure 26)

• NDI Discovery — these settings determine what streams are reported in the Stream Name 
menu on the NDI Stream > Receiver Configuration tab. Any edits made in the NDI Discovery area 
affect all decoders/encoders on the ULTRIX-MOD-NDI.

• Global Stream Settings — these settings are applied to all encoders/senders and 
decoders/encoders across the ULTRIX-MOD-NDI. Note that editing the Global Stream Settings will 
not apply to existing streams until you reapply those streams individually to realize that change. 

Figure 26  Example of the Views > IO Module > NDI > NDI Access Tab

Table 15 summarizes the NDI Access tab. 

Rx Bandwidth 
(Mbps)

# Reports the bandwidth utilization (to the 
nearest 100Mbps) received on the network 
link and forwarded to the processor on the 
ULTRIX-MOD-NDI ENET port

Enable Remote SSH Selected The ULTRIX-MOD-NDI can be accessed via a 
secure channel by a SSH server. This should 
only be selected if directed to do so by Ross 
Video Technical Support.

Cleared* Disables the ability for a user to log onto 
the ULTRIX-MOD-NDI via a SSH server

Table 15  Port Configuration — Views > IO Module > NDI > NDI Access

Item Parameters Description
Displaying 
(read-only)

slot#.MOD# Reports the ULTRIX-MOD-NDI you are configuring

NDI Discovery

Table 14  Port Configuration — Views > IO Module > NDI > Network (Continued)

Item Parameters Description
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Decoder Interfaces
This section outlines the decoder specific options when Views is set to IO Module > NDI > Inputs. 
(Figure 27) These options are used to select a network stream to receive the NDI stream and 
decode it. Once decoded, the stream is available as an SDI source in your active database.

NDI Stream Tab
The NDI Stream tab provides options to configure the NDI decoders of the ULTRIX-MOD-NDI. 

Receive Group(s) <text> Enables you to filter the NDI Discovered Sources 
table to list only those sources included in the 
specified Group name. This also determines what is 
populated in the menus in the NDI > NDI Stream > 
Receiver Configuration > Stream Name.

NDI Discovered 
Sources

<text> Provides a list of the auto detected network streams 
the ULTRIX-MOD-NDI is receiving. Note that the 
naming format of a network stream is determined 
by its device.

Global Stream Settings

Discovery Server 
IP(s)

# Specifies the IP address range when using an NDI 
Discovery Server for stream discovery. Multiple IP 
addresses can be used by separating them with a 
comma (e.g. 127.0.0.1,10.0.0.1,10.0.0.2).

Enable Selected Enables access to an NDI Discovery Server to 
facilitate stream discovery instead of using mDNS. 
The user is required to set up the NDI discovery 
server independently. For instructions about setting 
up the NDI discovery server, refer to the NDI SDK 
documentation.

Cleared Disables this feature. 
The ULTRIX-MOD-NDI ignores the address(es) listed 
in the Discovery Server IP(s) field.

Table 15  Port Configuration — Views > IO Module > NDI > NDI Access (Continued)

Item Parameters Description
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Figure 27  Example of the Views > IO Module > NDI > Inputs > NDI Stream Tab

Table 16 summarizes the Inputs > NDI Stream tab. 

Table 16  Port Configuration — Views > IO Module > NDI > Inputs > NDI Stream

Item Parameters Description
Displaying 
(read-only)

slot#.MOD#-in[#] Reports the selection from the Detected NDI 
Streams table (left pane)

Receiver Configuration

Enable Selected Enables the selected input to receive and decode 
the NDI stream

Cleared Disables the NDI decoding via this stream

Stream Name <text> Specifies the unique identifier for the stream as 
determined by the NDI device. The maximum is 30 
characters.

Receive Mode # Specifies the transport protocol for receiving and 
decoding NDI streams

Enable Audio Selected Configures the decoder for audio streaming

Cleared Disables this feature

Status (read-only)

Stream State Running (Green) The decoder is initialized and operating correctly, 
and is attempting to receive the NDI stream

Stopped (Red) The decoder was stopped by the user and is not 
receiving an NDI stream

Runtime Error (Red) The decoder encountered an error and is no longer 
running

Video (read-only)
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Encoder Interfaces
This section outlines the NDI Stream options when Views is set to IO Module > NDI > Outputs.

NDI Stream Tab
The NDI Stream tab enables you to configure the sender streams of a selected ULTRIX-MOD-NDI.

Video Format # (Green) Reports the video format of the received stream. 
Refer to Table 10 for a list of supported video 
formats.

Video Source Inactive 
(Red)

A decoder is configured to receive an NDI stream 
from the network but the NDI source is removed 
from the network.
The SDI video input status remains unchanged, but 
the video output has frozen.

No Video Data (Red) The stream does not exist or was never sending any 
video frames

Format Unsupported 
(Red)

An attempt to receive a supported video format 
failed and the stream cannot be decoded

N/A (Red) The decoder was stopped by the user and is not 
receiving an NDI stream

Stream Type # Reports the type of compression used for NDI 
decoding. Only NDI-HB is supported at this time.

Audio (read-only)

Audio Format PCM (Green) Indicates the audio stream is valid with no errors

No Audio (Red) The source video does not include an audio stream

No Signal (Needs 
Video) (Red)

• The NDI source stream has no video data or is an 
unsupported format.

• Audio streams must be accompanied by an 
associated video stream.

• Audio-only NDI streams are not currently 
supported.

Audio Disabled (Red) The NDI Stream > Enable Audio box is not selected

Sample Rate 48kHz (Green) The sample rate is fixed to 48kHz.
The ULTRIX-MOD-NDI will attempt to perform 
sample rate conversion (SRC) to 48kHz for sources 
that have other sample rates.

Channel Count # Reports the audio channel count based on the 
maximum channel count of the current Operation 
mode (and not the source NDI Stream)

Table 16  Port Configuration — Views > IO Module > NDI > Inputs > NDI Stream (Continued)

Item Parameters Description
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Figure 28  Example of the Views > IO Module > NDI > Outputs > NDI Stream Tab

Table 17 summarizes the Outputs > NDI Stream tab. 

Table 17  Port Configuration — Views > IO Module > NDI > Outputs > NDI Stream

Item Parameters Description
Displaying 
(read-only)

slot#.MOD#-out[#] Reports the selection from the Detected NDI 
Streams table

Sender Configuration

Enable Selected Enables the sender to transmit the routed SDI video 
as an SDI stream

Cleared Disables the transmission of the NDI stream

NDI Device Alias <text> Specifies a unique identifier for this 
ULTRIX-MOD-NDI. This name is used to identify the 
streams this ULTRIX-MOD-NDI is managing.

Stream Name <text> Provides a unique identifier for the decoded 
stream. This name is used to identify the data within 
your network.

Group(s) <text> Specifies a unique identifier for the group

Transport Mode # Specifies the transport protocol for encoding and 
sending NDI streams 

Enable Audio Selected Configures the encoder for audio streaming

Cleared Disables this feature

Channel Count # Specifies the audio channel count of the 
transmitted NDI stream. 
The maximum number depends on the Operation 
mode set for this ULTRIX-MOD-NDI.

Status (read-only)
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Stream State Running (Green) The encoder is initialized and operating correctly, 
and is attempting to send the NDI stream

Stopped (Red) The encoder was stopped by the user and is not 
sending an NDI stream

Runtime Error (Red) The encoder encountered an error and is no longer 
running

Video (read-only)

Video Format # (Green) Indicates the video format detected on the stream

Format Unsupported Indicates the format is unsupported. Refer to 
Table 10 for a list of supported video formats.

No Signal The NDI encoder does not detect a valid SDI signal 
from the Ultrix router

N/A (Red) The encoder was stopped by the user and is not 
receiving an NDI stream

Stream Type # Reports the type of compression used for NDI 
encoding. Only NDI-HB is supported at this time.

Audio (read-only)

Audio Format PCM (Green) Indicates the audio stream is valid with no errors

No Signal (Needs 
Video) (Red)

The SDI video signal routed to the NDI encoder is 
invalid. Audio-only NDI streams are not currently 
supported.

Audio Disabled (Red) The NDI Stream > Enable Audio box is not selected

Sample Rate #kHz (Green) Reports the sample rate.
The Ultrix router will always supply audio at 48KHz.

Channel Count # Reports the audio channel count of the transmitted 
NDI stream

Table 17  Port Configuration — Views > IO Module > NDI > Outputs > NDI Stream (Continued)

Item Parameters Description
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ULTRIX-MOD-SDI
This chapter outlines the ULTRIX-MOD-SDI features, and cabling designations.

For More Information on...
• installing an ULTRIX-MOD-SDI in the ULTRIX-MODX-IO blade, refer to “Installing a Module”.
• configuring the ports, refer to “Port Configuration”.

Features
Each ULTRIX-MOD-SDI provides:

• 4 UHD video inputs via HD-BNCs
• 4 UHD video outputs via HD-BNCs
• Support for YUV 4:2:2 10bit color space
• Support for 16 channels of embedded audio per video link
• Support for 24bit, 48kHz audio
• Hot-swappable
• One Multiviewer Head (refer to Figure 31)

Supported Video Formats
Table 18 outlines the video formats that the ULTRIX-MOD-SDI supports.

Table 18  Supported Video Formats — ULTRIX-MOD-SDI

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

SD

480 I 59.94

576 I 50

HD

720 P 60

720 P 59.94

720 P 50

1080 I 60

1080 I 59.94

1080 I 50

1080 I 24

1080 I 23.98

1080 P 30

1080 P 29.97

1080 P 25

1080 P 24
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Hardware Overview
Each ULTRIX-MOD-SDI provides 4 outputs and 4 inputs via HD-BNCs. (Figure 29)

Figure 29  Hardware Features of the ULTRIX-MOD-SDI

1. Retaining Screws

There is a retaining screw on each end of the module. These screws affix the module to the blade. 

2. OUT 1-4

Each ULTRIX-MOD-SDI provides non-blocking connectivity for up to 4 SDI outputs with a 
maximum of 16 SDI outputs in a single ULTRIX-MODX-IO blade. The ports are labeled as 1-4 
starting with the leftmost port. This numbering scheme is also reported in the DashBoard 
interfaces.

1080 P 23.98

3G

1080 P 60

1080 P 59.94

1080 P 50

6G

2160 P 30

2160 P 29.97

2160 P 25

2160 P 24

2160 P 23.98

12G (UHD)

2160 P 60

2160 P 59.94

2160 P 50

1) Retaining Screws 2) OUT 1-4 3) IN 1-4

Table 18  Supported Video Formats — ULTRIX-MOD-SDI (Continued)

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

1 1OUT IN2 3 2 34 4

ULTRIX-MOD-SDI

2 3

1 1
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3. IN 1-4

Each ULTRIX-MOD-SDI provides non-blocking connectivity for up to 4 SDI inputs with a maximum 
of 16 SDI inputs in a single ULTRIX-MODX-IO blade. The ports are labeled as 1-4 starting with the 
leftmost port. This numbering scheme is also reported in the DashBoard interfaces.

Gearbox Cabling
Figure 30 illustrates the connections allocated for Gearbox groups on an ULTRIX-MODX-IO with 
four ULTRIX-MOD-SDI.

Figure 30  Example of Gearbox Mapping on a Single ULTRIX-MODX-IO Blade with Four ULTRIX-MOD-SDI

Outputs
When you configure an ULTRIX-MOD-SDI as a Gearbox output group, the signals of the four 3G 
Level A channels are grouped together to provide a single 12G signal to an output. Table 19 
outlines the default outputs for the ULTRIX-MODX-IO blade with four ULTRIX-MOD-SDI.

Inputs
When you configure an ULTRIX-MOD-SDI as a Gearbox input group, the signals of the four 3G Level 
A channels are multiplexed together. Table 20 outlines the default inputs for the ULTRIX-MODX-IO 
blade with four ULTRIX-MOD-SDI.

Table 19  Gearbox Mapping — Default Output Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
1 MOD1.out[1] MOD1.out[2] MOD1.out[3] MOD1.out[4]

2 MOD2.out[1] MOD2.out[2] MOD2.out[3] MOD2.out[4]

3 MOD3.out[1] MOD3.out[2] MOD3.out[3] MOD3.out[4]

4 MOD4.out[1] MOD4.out[2] MOD4.out[3] MOD4.out[4]

Table 20  Gearbox Mapping — Default Input Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
1 MOD1.in[1] MOD1.in[2] MOD1.in[3] MOD1.in[4]

2 MOD2.in[1] MOD2.in[2] MOD2.in[3] MOD2.in[4]

3 MOD3.in[1] MOD3.in[2] MOD3.in[3] MOD3.in[4]

4 MOD4.in[1] MOD4.in[2] MOD4.in[3] MOD4.in[4]

ULTRIX-MODX-IO

!

BA C D 1 1OUT IN2 3 2 34 4

ULTRIX-MOD-SDI

1 1OUT IN2 3 2 34 4

ULTRIX-MOD-SDI

1 1OUT IN2 3 2 34 4

ULTRIX-MOD-SDI

1 1OUT IN2 3 2 34 4

ULTRIX-MOD-SDI

GROUP
4

1 1

GROUP
1

GROUP
3

GROUP
2
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UltriScape Cabling
Figure 31 illustrates the connections allocated for UltriScape Heads on an ULTRIX-MODX-IO with 
four ULTRIX-MOD-SDI.

Figure 31  Example of UltriScape Head Mapping on a Single ULTRIX-MODX-IO Blade with Four ULTRIX-MOD-SDI

UltriSync Cabling
The UltriSync-UHD license is available on 3 inputs per blade. When cabling your module(s), make a 
note of the ports that will be used as inputs. Refer to “Hardware Overview” for port designations.

UltriProc Cabling
The UltriProc cabling designations depend on the data rate mode.

For More Information on...
• setting the data rate for UltriProc, refer to the Ultrix User Guide for your router.

Data Rates of 3Gbps

When the UltriProc operates at data rates up to 3Gbps1, the license is available on the even 
numbered inputs (Input 2, 4) or outputs (Output 2, 4) per module.

Figure 32 illustrates the connections allocated for UltriProc on the ULTRIX-MODX-IO blade (with 
four ULTRIX-MOD-SDI) for data rates up to 3Gbps.

Figure 32  Example of UltriProc 3Gbps Mapping on a Single ULTRIX-MODX-IO Blade

Data Rates of 6Gbps or 12Gbps

When the UltriProc operates at data rates up to 6Gbps2 and 12Gbps3, the license is available on 
Input 2 or Output 2. This mode also requires an UltriSpeed license.

Figure 33 illustrates the connections allocated for UltriProc on the ULTRIX-MODX-IO blade (with 
four ULTRIX-MOD-SDI) for data rates up to 6Gbps and 12Gbps.

Figure 33  Example of UltriProc 6Gbps or 12Gbps Mapping on a Single ULTRIX-MODX-IO Blade

1. 1080p 50/59.94/60Hz
2. 2160p 23.98/24/25/29.97/30Hz
3. 2160p 50/59.94/60Hz
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UltriScape
Head 1
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Head 2
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ULTRIX-MOD-SFP
This chapter outlines the ULTRIX-MOD-SFP features, and cabling designations.

For More Information on...
• installing an ULTRIX-MOD-SFP in the blade, refer to “Installing a Module”.
• the SFP modules that the router supports, refer to the Ultrix SFP Module User Guide.
• configuring the ports, refer to “Port Configuration”.

Features
Each ULTRIX-MOD-SFP provides:

• 4 UHD video I/O via UNDI and/or SDI links
• 64 Channels of audio
• Hot-plug detection of SFP modules in DashBoard
• Hot-swappable
• One Multiviewer Head (refer to Figure 36)

Supported Formats
Table 21 outlines the video formats that the ULTRIX-MOD-SFP supports. 

Table 21  Supported Video Formats

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

HD

720 P 60

720 P 59.94

720 P 50

1080 I 60

1080 I 59.94

1080 I 50

1080 P 30

1080 P 29.97

1080 P 25

1080 P 24

1080 P 23.98

3G

1080 P 60

1080 P 59.94

1080 P 50

6G

2160 P 30



76 • ULTRIX-MOD-SFP ULTRIX-MODX-IO User Guide (v3-rev7)

Hardware Overview
Each ULTRIX-MOD-SFP provides up to 4 ports that can be populated with supported SFP modules. 
The ports are labeled as 1-4 starting with the leftmost port. This numbering scheme is also reported 
in the DashBoard interfaces.

 Figure 34 shows the ports unpopulated.

Figure 34  Hardware Features of the ULTRIX-MOD-SFP

1. Retaining Screws

There is a retaining screw on each end of the module. These screws affix the module to the blade. 

2. SFP 1-4 Ports

Each port can be populated with a Small Form-factor Pluggable (SFP) module from the factory or 
by installing modules in the field. When an SFP port is populated on the module, its status is 
reported in DashBoard and options are provided for mapping and configuring the I/O as 
required. For a list of SFP modules available from Ross Video, refer to the ULTRIX SFP Modules 
Guide. 

2160 P 29.97

2160 P 25

2160 P 24

2160 P 23.98

12G (UHD)

2160 P 60

2160 P 59.94

2160 P 50

1) Retaining Screws 2) SFP 1-4 Ports

Notice — Every time you are required to insert a connector into a device or mating sleeve, you must 
clean the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility 
practices of cleaning fiber optic connectors.

Connectors must always be inserted into a device or have a dust cap on.

Table 21  Supported Video Formats (Continued)

Resolution 
(lines)

Interlace / 
Progressive

Frame Rate 
(Hz)

1 2 3 4

ULTRIX-MOD-SFP

1

2

1
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Gearbox Cabling
Figure 35 illustrates the connections allocated for Gearbox groups on an ULTRIX-MODX-IO with 
four ULTRIX-MOD-SFP.

Figure 35  Example of Gearbox Mapping on a Single ULTRIX-MODX-IO Blade with Four ULTRIX-MOD-SFP

Outputs
When you configure an ULTRIX-MOD-SFP as a Gearbox output group, the signals of the four 3G 
Level A channels are grouped together to provide a single 12G signal to an output. Each 
ULTRIX-MOD-SFP can be configured as an output group. Table 22 outlines the default outputs for 
the ULTRIX-HDX-IO blade with four ULTRIX-MOD-SFP.

Inputs
When you configure an ULTRIX-MOD-SFP as a Gearbox input group, the signals of the four 3G Level 
A channels are multiplexed together. Table 23 outlines the default inputs for the ULTRIX-HDX-IO 
blade with four ULTRIX-MOD-SFP.

Table 22  Gearbox Mapping — Default Output Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
1 MOD1.out[1] MOD1.out[2] MOD1.out[3] MOD1.out[4]

2 MOD2.out[1] MOD2.out[2] MOD2.out[3] MOD2.out[4]

3 MOD3.out[1] MOD3.out[2] MOD3.out[3] MOD3.out[4]

4 MOD4.out[1] MOD4.out[2] MOD4.out[3] MOD4.out[4]

Table 23  Gearbox Mapping — Default Input Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
1 MOD1.in[1] MOD1.in[2] MOD1.in[3] MOD1.in[4]

2 MOD2.in[1] MOD2.in[2] MOD2.in[3] MOD2.in[4]

3 MOD3.in[1] MOD3.in[2] MOD3.in[3] MOD3.in[4]

4 MOD4.in[1] MOD4.in[2] MOD4.in[3] MOD4.in[4]
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UltriScape Cabling
Figure 36 illustrates the connections allocated for UltriScape Heads on an ULTRIX-MODX-IO with 
four ULTRIX-MOD-SFP.

Figure 36  Example of UltriScape Head Mapping on a Single ULTRIX-MODX-IO Blade

UltriSync Cabling
The UltriSync-UHD license is available on 3 inputs per blade. When cabling your module(s) make a 
note of the ports that will be used as inputs. 

ULTRIX-MODX-IO

!

BA C D 1 2 3 4

ULTRIX-MOD-SFP

1 2 3 4

ULTRIX-MOD-SFP

1 2 3 4

ULTRIX-MOD-SFP

1 2 3 4

ULTRIX-MOD-SFP

UltriScape
Head 3

UltriScape
Head 1

UltriScape
Head 2
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DashBoard Overview
This chapter provides a general overview of how to access the interfaces, tabs, and menus for an 
ULTRIX-MODX-IO blade and its modules in DashBoard.

Overview
The Port Configuration page enables you to choose how to display the settings and read-only 
fields for your blades. A Views toolbar provides menus to filter what settings and fields are reported 
on the Port Configuration page. 

By default, selecting an ULTRIX-MODX-IO blade displays its information in a table where the Views is 
set to Baseband > Ports > Inputs. This format is similar to other blades in the router. (Figure 37)

Figure 37  Example of the Baseband View for an ULTRIX-MODX-IO

If you select the same ULTRIX-MODX-IO blade, but set its Views to IO Module > SDI > Inputs, the 
information is displayed in a different format where the left pane displays the status, and the right 
pane displays the SDI input settings in a series of vertical tabs. (Figure 38)

Figure 38  Example of the IO Module View for an ULTRIX-MODX-IO
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If you are configuring multiple ULTRIX-MODX-IO blades and wish to edit the settings 
simultaneously, you can choose to display the IO Module interface by selecting the Multi button in 
the top left corner, and then setting the Views to IO Module. Filter the information by selecting the 
module type (SDI, SFP), and signal (Inputs, Outputs). The Port Configuration interface updates to 
display the status and settings for only those ports that match the Views filter criteria. For example, 
Figure 39 is a View of only the inputs of ULTRIX-MODX-IO blades that have at least one 
ULTRIX-MOD-SDI module.

Figure 39  Example of Multiple Blades Selected in the Port Configuration > Views > IO Module Interface

1. Multi Button

Select this button when you wish to display more than one ULTRIX-MODX-IO blade and their 
modules in the Port Configuration interface. Once selected, notice that the button for each 
ULTRIX-MODX-IO blade is also now lit (selected). You can also click each blade button (next to the 
Multi button) to select/deselect the blades to view. A lit button indicates that the blade is included 
in the Available Ports table.

2. Views Toolbar

Use the Views toolbar to filter the blades and ports reported on the Port Configuration 
interface. There are three menus (left to right):

› The first menu determines the information to display. For the ULTRIX-MODX-IO, select IO 
Module.

› The second menu determines the module type to display. For example, select SDI to report 
only the ULTRIX-MODX-SDI modules.

› The third menu determines the signal (Inputs, or Outputs). 

3. Map of the ULTRIX-MODX-IO Blade

This area displays a map of an ULTRIX-MODX-IO blade as filtered using the Views menus. 

› If a single blade is selected, select a port directly from the map to display its settings on the 
Port Configuration interface. 

› If the Multi button is also selected, a generic map displays where each module is represented 
with four buttons. 

The two read-only status fields, located directly under the blade map, indicate the overall 
communication status.
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4. Available Ports Table

This table lists the available modules and ports as determined by the selections made in the 
Views toolbar. A column of indicators report the video and audio status for each port.

The Ultrix router automatically detects when an ULTRIX-MODX-IO blade is populated with 
modules and their active ports. Each signal is made available in the routing system. The signals 
are named using the Slot#.Module#-Port[#] nomenclature. For example, 
slot7.MOD1-in[3] would represent input 3 of the first module installed in the ULTRIX-MODX-IO 
blade of slot 7.

5. Configuration Options

The tabs, menus, and settings that display in this area are determined by the Views menus, the 
specific slot you selected (either by selecting its row in the Available Ports table, or by clicking its 
icon on the map), and whether the Multi button was selected.

When multiple blades are selected, an  icon displays next to the settings that are common to 
all ports but are not set to the same values. 

Customizing the IO Module Interface
The Port Configuration interface provides the Views toolbar that helps you to quickly filter the 
ULTRIX-MODX-IO ports, modules, and signal types. This enables you to display only the settings you 
need to modify, or filter to monitor specific ports. 

Displaying the IO Module Interface
This section outlines how to display the IO Module interface and filter the information using the 
Views toolbar.

To display the IO Module interface in DashBoard

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Systems sub-node.

5. Expand the Configuration sub-node.

6. Double-click the Ultrix node.

 The Device Configuration interface opens.

7. Select  from the top toolbar.

The Port Configuration page opens.

8. If you want to edit the settings for all or selected ULTRIX-MODX-IO blades, click Multi in the top 
left corner and select/deselect the blades to edit.
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9. From the Views toolbar:

a. Use the first menu to select IO Module.

b. Use the second menu to select the module type.

In the following example, the user wants to display the ULTRIX-MOD-SDI modules.

c. Use the third menu to select the signal type.

In the following example, the user wants to display the inputs of the modules.

The IO Module interface now displays the tabs, menus, and settings for the selected port(s). By 
default, the first port in the table is automatically selected. 
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Selecting the Ports to Configure
Use this procedure if you have modules and ports of the same type and wish to access and 
configure their settings via a single interface.

To select a specific port

1. Navigate to the IO Module interface as outlined in “To display the IO Module interface in 
DashBoard”.

2. In the Available Ports table (located in the left pane of the window), select the port.

To select multiple ports

1. Navigate to the IO Module interface as outlined in “To display the IO Module interface in 
DashBoard”.

2. In the Available Ports table (located in the left pane of the window), select the first port.

3. To select a consecutive series of ports:

a. Press and hold Shift.

b. Select the last port in the series.

The selected rows are highlight in blue. In the following example, the user selected inputs 2-4 
of the ULTRIX-MOD-SDI module in the FLEX slot of an ULTRIX-FR5.

4. To select multiple ports:

a. Press and hold Ctrl.

b. Select each port in the series.

The selected rows are highlight in blue. 

In the following example, the user selected the first input of each ULTRIX-MOD-SDI module.
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5. Locate the first setting you wish to edit.

• Settings that are common to the selected ports, but are assigned different values, are noted 
with an . Proceed to step 7.

• Settings that are assigned the same value for the selected ports do not display the icon. In the 
above example, the 2-SI group menu is set to Disable for all ports. Proceed to step 6.

6. Edit the setting as required. Refer to “Port Configuration Options” for menu options.

7. If you are editing a setting that is not consistently set to the same value for the ports:

a. Click  to display the dialog for the setting.

In the following example, the user is modifying the Matte Format values for the selected 
ports.

b. Locate the rows for the ports to edit.

c. Edit the cells in each column as required.

d. Select the Modify box for each port to apply the new value to.

e. Click OK to apply the changes and close the dialog.

 

For More Information on...
• the available port settings, refer to “Port Configuration Options”.
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Port Configuration
Once the ULTRIX-MODX-IO blade and the modules are installed, you can proceed to configure the 
AUX ports, and module I/O ports in DashBoard. This chapter provides a brief overview of the 
configuration options in DashBoard for the blade I/O ports and is applicable to all module types.

Before You Begin
You may also need to install an:

• Ultrimix-Dante license to enable 64 x 64 input/output audio channels via ethernet on the AUX C 
port for use within an Audinate® Dante® system. 

 UltriStream and Ultrimix-Dante cannot be enabled simultaneously on the same slot.

• Ultrimix-MXR license to enable the configuration and use of audio mixer soft panels.
• UltriProc or UltriProc-3DLUT license for each port to be assigned to an UltriProc engine for color 

correction, Proc Amps, and HDR conversion.
• Ultriscape license for each port that will be used to provide an Ultriscape Head output.
• UltriSpeed license if the blade includes one of the following SFP modules: SFP-HDB-IN-12G, 

SFP-FIBER-12G, and/or SFP-HDB-OUT-12G.
• UltriSRC license for each port to be configured for an asynchronous MADI input.
• UltriStream license to enable the encoding of one NDI stream of a configured Ultriscape 

Multiviewer Head per blade.
• UltriSync license for each 3G input to enable alignment to the router sync.
• Ultrisync-UHD for each input frame sync license to support UHD video rates. 

For More Information on...
• installing license keys for your Ultrix router, refer to its user guide.

Using the Device Configuration Interface
The Device Configuration interface in DashBoard enable you to define the physical outputs, inputs, 
and communication ports of the Ultrix router. You can also monitor the overall status of the router, 
or just the status of a specific signal path or port on the rear panel. Use the top toolbar of the 
interface to navigate the interfaces for configuring your blades and ports on the router.

This section summarizes the steps specific to configuring the ULTRIX-MODX-IO blade and its 
modules using the following Device Configuration interfaces:

•  Port Configuration — reports individual I/O port status and settings. Selecting a slot 
updates the table for all installed ports. Selecting a port displays only the options for that port 
(the label under the port icon is lit blue). You can also choose to filter the information displayed in 
the table (e.g. only inputs, or only outputs). Refer to “Customizing the IO Module Interface” for 
more details.

•  SFP Configuration — configure each populated AUX port on the blade.

For More Information on...
• the Device Configuration interface, refer to the Ultrix User Guide for your router.
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Overview
The Ultrix router automatically detects the ULTRIX-MODX-IO blade and its modules (Figure 40). 
Each signal is made available in the routing system. The signals are initially named using the 
standard Slot#.Module#-Port[#] nomenclature. For example, slot1.MOD2-in[3]would 
represent input 3 of the second module installed in an ULTRIX-MODX-IO blade located in router slot 
1.

Figure 40  Example of the Device Configuration Interface with Multiple ULTRIX-MODX-IO Blades

Configuring an AUX Port
Once the SFP module is installed in an AUX port of the ULTRIX-MODX-IO blade, you can specify the 
port type using the options on the SFP Configuration interface. 

 The FLEX slot in the ULTRIX(-NS)-FR5 does not support any I/O in the AUX ports.

To configure an AUX port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The SFP Configuration interface opens with the AUX Ports tab automatically selected. 

 The SFP Ports tab is only applicable when configuring an ULTRIX-SFP-IO blade. Refer to the Ultrix 
Installation Guide for your router for details on the ULTRIX-SFP-IO.

6. From the Slots table, select each router slot that houses an ULTRIX-MODX-IO blade.

The right pane of the tab updates to display a list of available ports based on the slot(s) selected.
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7. In the rightmost pane, locate the row for the port you want to configure.

8. In the SFP column, assign a function to the port. Choose from the following:

Other options may also be available depending on the licenses enabled on your router. Refer to 
the Ultrix User Guide for your router for details.

• None — the port is unpopulated or you do not wish to include this port in the routing system.
• SDI Video — the SFP module is one that supports SDI video signals.
• MADI — the SFP module is one that supports MADI audio signals. 

9. In the MADI I/O Size column, specify the channel quantity as per your facilities' standard.

10. Click Apply to save your changes.

Port Configuration Options
This section outlines the options in the Port Configuration interface for the ULTRIX-MODX-IO based 
on the Views settings. Some options may depend on the module type and installed license keys.

When configuring multiple ULTRIX-MODX-IO blades, filter the Port Configuration interface by 
using the Views and Options menus as described in “Customizing the IO Module Interface”.

Baseband View
When in Baseband view, you can choose to view options based on the port or channel, and signal 
type (inputs or outputs).

Baseband > Ports > Inputs View

This section summarizes the options when Views is set to Baseband > Ports > Inputs.
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Figure 41  Example of the Baseband > Ports > Inputs View

Table 24 summarizes the options when Views is set to Baseband > Ports > Inputs.

Table 24  Port Configuration — Views > Baseband > Ports > Inputs

Item Parameters Description
Group # Indicates the Gearbox group where Group 1 is the 

first module in the blade. Refer to Figure 30 and 
Figure 35 for mapping details.

Physical Address 
(read-only)

slotx.MODy-z[#] Lists the physical ports, in ascending order where:
• x represents the router slot number
• y represents the module slot number
• z represents the signal type (in or out)
• # represents the port

Video (read-only) # If a port is used for video signals, this field indicates 
the video format

Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).

Timing Lines 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of lines.

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference.

Timing Pixels 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of pixels. 

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Timing Pixels 
(read-only)

Async There is no timing relationship between the input 
signal and the frame reference

Frame Sync 
Delay

# frame(s) Specifies the frame buffer size for the selected input 
port
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LoS Statea Black Sets the input to black during the loss of signal

Freeze Sets the input to the last valid frame of video before 
the loss of signal

UDC Disable This port will not use UltriFormat

# Specifies the video format that UltriFormat will 
convert this input signal to. Note that the 
UltriFormat output must match the router 
reference format. Refer to the Ultrix User Guide for 
your router for details on UltriFormat.

UDC Fallback Bypass The format converter is bypassed; the output 
format matches the input

Black The output is forced to black (using the UDC setting) 
but remains synchronized to the SPG. This is useful 
for preserving downstream sync without valid input. 
Refer to the Ultrix User Guide for your router for 
details.

2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Signal Medic 
(read-only)b

Not available This port does not support the Gearbox feature.

Good This port is included in a Gearbox setup.

Replaced This port can be included in a Gearbox setup but is 
currently not included in the 12G link.

Matte Gen Disable Disable an internally generated test pattern. This is 
the default.

Static Generates a static color matte

Bouncing Box Generates a static color matte with a 
complimentary colored moving box

Luma Sequence Generates a luminance shifting sequence based on 
chosen color

Matte Format # Specifies the signal format of the generated test 
pattern. If you select Auto, the test pattern 
automatically matches the incoming signal type.

Matte Color # Specifies the color of the test signal

Table 24  Port Configuration — Views > Baseband > Ports > Inputs (Continued)

Item Parameters Description
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Baseband > Ports > Outputs View

This section summarizes the options when Views is set to Baseband > Ports > Outputs.

Figure 42  Example of the Baseband > Ports > Outputs View

Table 25 summarizes the options when Views is set to Baseband > Ports > Outputs.

Audio Bypass Selected When Audio Bypass is enabled for an input, the 
audio will follow the SDI regardless of any individual 
audio channel routing or configuration on the 
output. 
The individual channels of an input in Bypass mode 
are still de-multiplexed and available for audio 
routing via the audio matrix.

Cleared Disables this feature

a. This affects Ultriscape and routed destinations.
b. Use this field to replace a missing 3G signal when one or more of the four 3G signals for a Gearbox 

configuration are unavailable.

Table 25  Port Configuration — Views > Baseband > Ports Outputs

Item Parameters Description
Group # Indicates the Gearbox group where Group 1 is the 

first module in the blade. Refer to Figure 30 and 
Figure 35 for mapping details.

Physical Address 
(read-only)

slotx.MODy-z[#] Lists the physical ports, in ascending order where:
• x represents the router slot number
• y represents the module slot number
• z represents the signal type (in or out)
• # represents the port

Video (read-only) # If a port is used for video signals, this field indicates 
the video format

Table 24  Port Configuration — Views > Baseband > Ports > Inputs (Continued)

Item Parameters Description
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Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).

2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Sub-Image ID 3G Some legacy equipment does not accept a 2SI 
SMPTE-352 payload identifier for quad-link SDI. You 
may need to select this if you are connecting legacy 
equipment to the specified output on the 
ULTRIX-MODX-IO.

2SI Set the SMPTE-352 payload identifier to 2SI for 
quad-link.

Clean Switch 
Status 
(read-only)

Locked The specified output is locked to its input.

Not Locked The specified output is not locked to its input.

Clean Switch Selected Clean Switch is applied to the specified output. The 
Clean Switch Delay value is applied.

Cleared Clean Switch is not applied to the specified output.

Clean Switch 
Mode

Reference Clean Switch is based on the reference signal 
available on the REF port of the router

Input Clean Switch is based on the input signal available 
on the specified port of the router

Clean Switch 
Delay

# Specifies the Clean Switch buffer depth. Select 
between 1/16 to full line to clean switch between 
signals with slight timing offsets.

Trigger # Specifies which reference signal trigger to use. Refer 
to the Ultrix User Guide for your router.

Table 25  Port Configuration — Views > Baseband > Ports Outputs (Continued)

Item Parameters Description
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Baseband > Channels > Inputs View

This section summarizes the options when Views is set to Baseband > Channels > Inputs.

Figure 43  Example of the Baseband > Channels > Inputs View

Table 26 summarizes the columns that display when Views is set to Baseband > Channels > Inputs. 

Transition Cut The audio input channel is immediately switched to 
its selected output. A transition to or from Dolby® 
will always be a Cut transition regardless of what 
the Transition setting is set to.

V Fade The original audio input channel fades down to 
silence followed by the new input channel fades up 
from silence to unity gain level

X Fade The original audio input channel fades down to 
silence as the new input fades up from silence, and 
both will be mixed

Cut Fade The original audio input channel cuts to silence and 
the new input fades up from silence to unity gain 
level

Fade Cut The original audio channel fades down to silence 
and the new input is cut in at unity gain level.

Quiet Cut The original audio channel performs a V Fade 
transition with a 5ms duration

Duration (ms) # Specifies the length of the audio fade, in 
milliseconds, between audio transitions

Table 25  Port Configuration — Views > Baseband > Ports Outputs (Continued)

Item Parameters Description
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Baseband > Channels > Outputs View

This section summarizes the options when Views is set to Baseband > Channels > Outputs.

Table 26  Port Configuration — Views > Baseband > Channels > Inputs

Item Parameters Description
ID (read-only) slot#.MOD#-port[#].type.ch Auto-generated identifier for the channel where:

• slot# represents which slot in the matrix the 
socket is located in

• MOD# represents the module slot in the blade
• port[#] identifies the physical input or output 

socket
• type identifies the generic signal type (e.g. audio)
• ch identifies the audio channel within an SDI 

stream
For example, slot1.MOD2-out[4].audio.ch10.

Label 
(read-only)

<text> Reports the text label that identifies the port in 
other interfaces of the database. This virtual label is 
used instead of the slot.port.type.channel format 
for logical label assignment. 
For example, you might re-name the port: 
slot1.AUXA.audio.ch1 to OUT 1.

Signal 
(read-only)

Provides status information on the specified channel.

Gain (dB) # Provides a +/- 20dB gain range in 0.50dB 
increments. If you have added a gain to an input 
channel, the gain value specified for the output 
channel is an addition. 
For example, if you set the gain for an input to 10dB, 
then specify a gain of 2dB on the output, the total 
gain will be 12dB on the final output

Invert Selected Inverts the polarity of the audio signal for the 
selected channel

Cleared Disables this feature

Sum Selected Sum two adjacent audio channels. Each selected 
channel will carry the average of the two input 
channels ((A+B)/2). 
Select the Sum box for the first channel. The Sum 
box for the second channel is automatically 
selected.
When the input is summed, the original signals are 
no longer available for output.

Cleared Disables this feature

Audio Delay 
(ms)

# Applies up to 500ms of delay per channel. Note that 
an UltriSync license must be enabled to the port.
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Figure 44  Example of the Baseband > Channels > Outputs View

Table 27 summarizes the columns that display when Views is set to Baseband > Channels > 
Outputs. 

Table 27  Port Configuration — Views > Baseband > Channels > Outputs

Item Parameters Description
ID (read-only) slot#.MOD#-port[#].type.ch Auto-generated identifier for the channel where:

• slot# represents which slot in the matrix the 
socket is located in

• MOD# represents the module slot in the blade
• port[#] identifies the physical input or output 

socket
• type identifies the generic signal type (e.g. audio)
• ch identifies the audio channel within an SDI 

stream
For example, slot1.MOD2-out[4].audio.ch10.

Label 
(read-only)

<text> Reports the text label that identifies the port in 
other interfaces of the database. This virtual label is 
used instead of the slot.port.type.channel format 
for logical label assignment. 
For example, you might re-name the port: 
slot1.AUXA.audio.ch1 to OUT 1.

Signal 
(read-only)

Provides status information on the specified channel.

Gain (dB) # Provides a +/- 20dB gain range in 0.50dB 
increments. If you have added a gain to an input 
channel, the gain value specified for the output 
channel is an addition. 
For example, if you set the gain for an input to 10dB, 
then specify a gain of 2dB on the output, the total 
gain will be 12dB on the final output
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IO Module Views
This section summarizes the tabs, settings, and read-only fields when Views is set one of the IO 
Module options.

Table 28 summarizes the Module and Card tabs that are common to all IO Module interfaces.

Invert Selected Inverts the polarity of the audio signal for the 
selected channel

Cleared Disables this feature

Sum Selected Sum two adjacent audio channels. Each selected 
channel will carry the average of the two input 
channels ((A+B)/2). 
Select the Sum box for the first channel. The Sum 
box for the second channel is automatically 
selected.
When the input is summed, the original signals are 
no longer available for output.

Cleared Disables this feature

Tone Mode Enable Enable test tones for the specified channel

Disable Disables this feature

Tone Freq # Specifies the type of test tone to embed in the 
output

Table 28  Port Configuration — Views > IO Module

Item Parameters Description
Module Tab

Module ID slotx.MODy • slotx indicates the physical slot in the router that 
the blade in installed in

• MODy indicates the module slot on the blade (1-4)

Module Type # Indicates the type of module (ULTRIX-MOD-NDI, 
ULTRIX-MOD-SDI, or ULTRIX-MOD-SFP)

Serial 
Number

# Indicates the serial number of the module

Firmware 
Version

# Indicates the firmware version running on the 
module

PCBA Part 
Number

# Indicates the hardware version of the module

Current 
Temperature

# Indicates the current temperature (in Celsius) 
reported by the module 

N/A This module does not support temperature 
monitoring

Table 27  Port Configuration — Views > Baseband > Channels > Outputs (Continued)

Item Parameters Description
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IO Module > SDI > Inputs

Set the Views to SDI > Inputs to display the options for configuring the input BNCs of an 
ULTRIX-MOD-SDI module. Select the Multi button to display all the ULTRIX-MOD-SDI module ports.

Figure 45  Example of the IO Module > SDI > Inputs View

Table 29 summarizes the options when Views is set to Views > IO Module > SDI > Inputs.

Max 
Temperature

# Indicates the maximum temperature (in Celsius) 
supported by the module

N/A This module does not support temperature 
monitoring

Begin 
Upgrades

Contact Ross Technical Support for upgrade files, and details. Refer to 
“Upgrading the Software”.

Card Tab

ID slot# Indicates the slot in the router that this blade is 
located in

Serial 
Number

# Indicates the serial number of this blade

Firmware 
Version

# Indicates the firmware version running on this 
blade

Table 28  Port Configuration — Views > IO Module (Continued)

Item Parameters Description
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Table 29  Port Configuration — View > IO Module > SDI > Inputs

Item Parameters Description
Module # Indicates the module slot in the ULTRIX-MODX-IO 

blade

Physical Address 
(read-only)

slotx.MODy-z[#] Lists the physical ports, in ascending order where:
• x represents the router slot number
• y represents the module slot number
• z represents the signal type (in or out)
• # represents the signal index

Video (read-only) # If a port is used for video signals, this field indicates 
the video format

Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).

Video Tab

Timing Lines 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of lines.

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference.

Timing Pixels 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of pixels. 

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference

Frame Sync 
Delay

# frame(s) Specifies the frame buffer size for the selected input 
port

LoS Statea Black Sets the input to black during the loss of signal

Freeze Sets the input to the last valid frame of video before 
the loss of signal

UDC Disable This port will not use UltriFormat

# Specifies the video format that UltriFormat will 
convert this input signal to. Note that the 
UltriFormat output must match the router 
reference format. Refer to “UltriFormat 
Configuration” for details on UltriFormat.

UDC Fallback Bypass The format converter is bypassed; the output 
format matches the input

Black The output is forced to black (using the UDC setting) 
but remains synchronized to the SPG. This is useful 
for preserving downstream sync without valid input. 
Refer to “UltriFormat Configuration”.
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2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Signal Medic 
(read-only)b

Not available This port does not support the Gearbox feature.

Good This port is included in a Gearbox setup.

Replaced This port can be included in a Gearbox setup but is 
currently not included in the 12G link.

Matte Gen Disable Disable an internally generated test pattern. This is 
the default.

Static Generates a static color matte

Bouncing Box Generates a static color matte with a 
complimentary colored moving box

Luma Sequence Generates a luminance shifting sequence based on 
chosen color

Matte Format # Specifies the signal format of the generated test 
pattern. If you select Auto, the test pattern 
automatically matches the incoming signal type.

Matte Color # Specifies the color of the test signal

Audio Bypass Selected When Audio Bypass is enabled for an input, the 
audio will follow the SDI regardless of any individual 
audio channel routing or configuration on the 
output. The individual channels of an input in 
Bypass mode are still de-multiplexed and available 
for audio routing via the audio matrix.

Cleared Disables this feature

a. This affects Ultriscape and routed destinations.
b. Use this field to replace a missing 3G signal when one or more of the four 3G signals for a Gearbox 

configuration are unavailable.

Table 29  Port Configuration — View > IO Module > SDI > Inputs (Continued)

Item Parameters Description
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IO Module > SDI > Outputs

Set the Views to SDI > Inputs to display the options for configuring the outputs BNCs of an 
ULTRIX-MOD-SDI module. Select the Multi button to display all the ULTRIX-MOD-SDI module output 
ports.

Figure 46  Example of the IO Module > SDI > Outputs View

Table 30 summarizes the options when Views is set to Views > IO Module > SDI > Outputs.

Table 30  Port Configuration — Views > IO Module > SDI > Outputs

Item Parameters Description
Module # Indicates the module slot in the blade where 1 is the 

first slot (leftmost) in the blade

Physical Address 
(read-only)

slotx.MODy-z[#] Lists the physical ports, in ascending order where:
• x represents the router slot number
• y represents the module slot number
• z represents the signal type (in or out)
• # represents the signal index

Video (read-only) # If a port is used for video signals, this field indicates 
the video format

Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.)

Video Tab

Sub-Image ID 3G Some legacy equipment does not accept a 2SI 
SMPTE-352 payload identifier for quad-link SDI. You 
may need to select this if you are connecting legacy 
equipment to the specified output on the 
ULTRIX-MODX-IO.

2SI Set the SMPTE-352 payload identifier to 2SI for 
quad-link

Clean Switch 
Status 
(read-only)

Locked The specified output is locked to its input

Not Locked The specified output is not locked to its input
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2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Clean Switch Selected Clean Switch is applied to the specified output. The 
Clean Switch Delay value is applied.

Cleared Clean Switch is not applied to the specified output

Clean Switch 
Mode

Reference Clean Switch is based on the reference signal 
available on the REF port of the router

Input Clean Switch is based on the input signal available 
on the specified port of the router

Clean Switch 
Delay

# Specifies the Clean Switch buffer depth. Select 
between 1/16 to full line to clean switch between 
signals with slight timing offsets.

Trigger # Specifies which reference signal trigger to use. Refer 
to the Ultrix User Guide for your router.

Transition Cut The audio input channel is immediately switched to 
its selected output. A transition to or from Dolby® 
will always be a Cut transition regardless of what 
the Transition setting is set to.

V Fade The original audio input channel fades down to 
silence followed by the new input channel fades up 
from silence to unity gain level

X Fade The original audio input channel fades down to 
silence as the new input fades up from silence, and 
both will be mixed

Transition Cut Fade The original audio input channel cuts to silence and 
the new input fades up from silence to unity gain 
level

Fade Cut The original audio channel fades down to silence 
and the new input is cut in at unity gain level

Quiet Cut The original audio channel performs a V Fade 
transition with a 5ms duration

Duration (ms) # Specifies the length of the audio fade, in 
milliseconds, between audio transitions

Table 30  Port Configuration — Views > IO Module > SDI > Outputs (Continued)

Item Parameters Description
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IO Module > SFP > Inputs

Set the Views to SFP > Inputs to display the options for configuring the input ports of an 
ULTRIX-MOD-SFP module. Select the Multi button to display all the ULTRIX-MOD-SFP module input 
ports.

Figure 47  Example of the IO Module > SFP > Inputs View

Table 31 summarizes the options when Views is set to Views > IO Module > SFP > Inputs.

Table 31  Port Configuration — View > IO Module > SFP > Inputs

Item Parameters Description
Module # Indicates the module slot in the ULTRIX-MODX-IO 

blade

Physical Address 
(read-only)

slotx.MODy-z[#] Lists the physical ports, in ascending order where:
• x represents the router slot number
• y represents the module slot number
• z represents the signal type (in or out)
• # represents the signal index

Video (read-only) # If a port is used for video signals, this field indicates 
the video format.

Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).

Video Tab

Timing Lines 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of lines.

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference.
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Timing Pixels 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of pixels. 

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference

Frame Sync 
Delay

# frame(s) Specifies the frame buffer size for the selected input 
port

LoS Statea Black Sets the input to black during the loss of signal

Freeze Sets the input to the last valid frame of video before 
the loss of signal

UDC Disable This port will not use UltriFormat

# Specifies the video format that UltriFormat will 
convert this input signal to. Note that the 
UltriFormat output must match the router 
reference format. Refer to “UltriFormat 
Configuration” for details on UltriFormat.

UDC Fallback Bypass The format converter is bypassed; the output 
format matches the input

Black The output is forced to black (using the UDC setting) 
but remains synchronized to the SPG. This is useful 
for preserving downstream sync without valid input. 
Refer to “UltriFormat Configuration”.

2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Signal Medic 
(read-only)b

Not available This port does not support the Gearbox feature.

Good This port is included in a Gearbox setup.

Replaced This port can be included in a Gearbox setup but is 
currently not included in the 12G link.

Matte Gen Disable Disable an internally generated test pattern. This is 
the default.

Static Generates a static color matte

Bouncing Box Generates a static color matte with a 
complimentary colored moving box

Luma Sequence Generates a luminance shifting sequence based on 
chosen color

Table 31  Port Configuration — View > IO Module > SFP > Inputs (Continued)

Item Parameters Description
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Matte Format # Specifies the signal format of the generated test 
pattern. If you select Auto, the test pattern 
automatically matches the incoming signal type.

Matte Color # Specifies the color of the test signal

Audio Bypass Selected When Audio Bypass is enabled for an input, the 
audio will follow the SDI regardless of any individual 
audio channel routing or configuration on the 
output. 
The individual channels of an input in Bypass mode 
are still de-multiplexed and available for audio 
routing via the audio matrix.

Cleared Disables this feature

SFP Statistics (read-only)

Vendor Name <text> Reports the vendor details of the SFP installed in the 
specified SFP port

Vendor PN # Reports the vendor part number of the SFP installed 
in the specified SFP port

Vendor SN # Reports the vendor serial number of the SFP 
installed in the specified SFP port

Temperature # Internal temperature (in Celsius) reported by the 
SFP installed in the specified port

Voltage # Indicates the present voltage through the SFP (in 
volts) 

Wavelength # If the SFP is a fiber module, this indicates the laser 
wavelength of the signal (in nanometers)

N/A The SFP is not a fiber module

a. This affects Ultriscape and routed destinations.
b. Use this field to replace a missing 3G signal when one or more of the four 3G signals for a Gearbox 

configuration are unavailable.

Table 31  Port Configuration — View > IO Module > SFP > Inputs (Continued)

Item Parameters Description
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IO Module > SFP > Outputs

Set the Views to SFP > Outputs to display the options for configuring the output ports of an 
ULTRIX-MOD-SFP module. Select the Multi button to display all the ULTRIX-MOD-SFP module 
output ports.

Figure 48  Example of the IO Module > SFP > Outputs View

Table 32 summarizes the options when Views is set to IO Module > SFP > Outputs.

Table 32  Port Configuration — Views > IO Module > SFP > Outputs

Item Parameters Description
Module # Indicates the module slot in the blade where 1 is the 

first slot in the blade

Physical Address 
(read-only)

slotx.MODy-z[#] Lists the physical ports, in ascending order where:
• x represents the router slot number
• y represents the module slot number
• z represents the signal type (in or out)
• # represents the signal index

Video (read-only) # If a port is used for video signals, this field indicates 
the video format.

Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).

Video Tab

Sub-Image ID 3G Some legacy equipment does not accept a 2SI 
SMPTE-352 payload identifier for quad-link SDI. You 
may need to select this if you are connecting legacy 
equipment to the specified output on the 
ULTRIX-MODX-IO.

2SI Set the SMPTE-352 payload identifier to 2SI for 
quad-link.

Clean Switch 
Status 
(read-only)

Locked The specified output is locked to its input.

Not Locked The specified output is not locked to its input.
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2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Clean Switch Selected Clean Switch is applied to the specified output. The 
Clean Switch Delay value is applied.

Cleared Clean Switch is not applied to the specified output.

Clean Switch 
Mode

Reference Clean Switch is based on the reference signal 
available on the REF port of the router

Input Clean Switch is based on the input signal available 
on the specified port of the router

Clean Switch 
Delay

# Specifies the Clean Switch buffer depth. Select 
between 1/16 to full line to clean switch between 
signals with slight timing offsets.

Trigger # Specifies which reference signal trigger to use. Refer 
to the Ultrix User Guide for your router.

Transition Cut The audio input channel is immediately switched to 
its selected output. A transition to or from Dolby® 
will always be a Cut transition regardless of what 
the Transition setting is set to.

V Fade The original audio input channel fades down to 
silence followed by the new input channel fades up 
from silence to unity gain level

X Fade The original audio input channel fades down to 
silence as the new input fades up from silence, and 
both will be mixed

Cut Fade The original audio input channel cuts to silence and 
the new input fades up from silence to unity gain 
level

Fade Cut The original audio channel fades down to silence 
and the new input is cut in at unity gain level.

Transition Quiet Cut The original audio channel performs a V Fade 
transition with a 5ms duration

Duration (ms) # Specifies the length of the audio fade, in 
milliseconds, between audio transitions

SFP Statistics (read-only)

Vendor Name <text> Reports the vendor details of the SFP installed in the 
specified SFP port

Vendor PN # Reports the vendor part number of the SFP installed 
in the specified SFP port

Table 32  Port Configuration — Views > IO Module > SFP > Outputs (Continued)

Item Parameters Description
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Gearbox Overview
A Gearbox is a group of four consecutive inputs or four consecutive outputs that are automatically 
grouped together in the routing database. The first port of the Gearbox group is automatically used 
for routing and Ultriscape, while the remaining three ports in the group are reserved but not used 
(they are not listed in the routing system database). 

Keep the following in mind when configuring a Gearbox group on the ULTRIX-MODX-IO blade:

• Signal Medic — a function that attempts to ‘repair’ the incoming Gearbox signal group if one of 
the four input stream is temporarily interrupted. The Signal Medic will replace the missing stream 
with an interpolated version derived from the other incoming signals. 

• Gearbox Timing — the Gearbox requires all four of the input signals be within 350ns of each 
other. Cable lengths to the Gearbox input should be as matched as practicable.

For More Information on...
• cabling a Gearbox group on the ULTRIX-MOD-SFP, refer to “ULTRIX-MOD-SFP”.
• cabling a Gearbox group on the ULTRIX-MOD-SDI, refer to “ULTRIX-MOD-SDI”.
• configuring a Gearbox, refer to the Ultrix User Guide for your router.

Ultrimix-Dante Overview
The Ultrimix-Dante license provides 64 x 64 input/output audio channels accessible via ethernet on 
the AUX C port of the ULTRIX-MODX-IO blade. 

Keep the following in mind when configuring the Ultrimix-Dante features:

• Ultrix identifies the Dante channels as a single pipeline consisting of 64 input and 64 output 
channels. 

• Audio sources from a Dante network can be configured as inputs into the router. The router can 
also output audio channels to the same Dante network.

• The AUX B audio channels are not available for use when Ultrimix-Dante is enabled on a blade. 
AUX B can still be used to route SDI video.

For More Information on...
• Ultrimix-Dante, refer to the Ultrix User Guide for your router.

UltriScape Overview
Ultriscape is the integrated Multiviewer for Ultrix routers. Use the Ultriscape Layout Editor to 
manage the layouts and the Ultriscape Head interface to assign sources to the Ultriscape Head 
outputs. You must have at least one Ultriscape license key installed to access the Ultriscape 
interfaces. 

Temperature # Internal temperature (in Celsius) of the SFP installed 
in the specified SFP port

Voltage # Indicates the present voltage through the SFP (in 
volts) 

Wavelength # If the SFP is a fiber module, this indicates the laser 
wavelength of the signal (in nanometers)

Table 32  Port Configuration — Views > IO Module > SFP > Outputs (Continued)

Item Parameters Description
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Keep the following in mind when configuring the Ultriscape features on an ULTRIX-MODX-IO blade:

• Each Ultriscape license enables one Multiviewer Head (output) per slot.
• Each slot supports up to three Multiviewer Heads.

For More Information on...
• the Ultriscape Head designations of the ULTRIX-MOD-SFP, refer to “ULTRIX-MOD-SFP”.
• the Ultriscape Head designations of the ULTRIX-MOD-SDI, refer to “ULTRIX-MOD-SDI”.
• the Ultriscape Head designations of other blades, refer to the installation guide for your router.
• configuring Ultriscape, refer to the Ultriscape User Guide.

UltriSync Overview
UltriSync allows the re-timing of asynchronous or time offset input signals to the frame reference. 
UltriSync is a per input feature and requires a license for each input that will be used by the 
UltriSync. 

Keep the following in mind when configuring the UltriSync features on an ULTRIX-MODX-IO blade:

• The UltriSync license allows for SDI data rates up to 3Gbps (1080p).
• The UltriSync-UHD license allows the Frame Sync to operate at up to 12Gbps (2160p) data rates. 

This license is available on 3 inputs per blade (AUX B or the first input of each module).

For More Information on...
• configuring the UltriSync feature, refer to the Ultrix User Guide for your router.

UltriClean Overview
UltriClean allows users to enable a Clean Switch mode and apply a line buffer (delay) on a per 
output basis. Incoming video is buffered based on the timing of the input, and is then output based 
on the timing of the router system reference (including any offsets added in the Triggers setup). 
Users can then switch between inputs that are not perfectly co-timed without perceiving any 
glitches of the incoming data. Video source timing must remain within the buffer to properly switch 
between sources (buffer depth is user-configurable).

For More Information on...
• configuring the UltriClean feature, refer to the Ultrix User Guide for your router.

UltriFormat Overview
UltriFormat converts the incoming video (of a supported video format) to any supported video 
format. A video frame synchronizer then allows the output video to be timed to an external video 
reference. Once an UltriFormat license is enabled on an input, the format conversion settings (UDC 
and UDC Fallback) in the Port Configuration interface are made available for that input.

For More Information on...
• configuring the UltriFormat feature, refer to the Ultrix User Guide for your router.

UltriSRC Overview
The UltriSRC license is a per port license enabling Sample Rate Conversion for MADI audio inputs. 
The sample rate conversion will re-sample incoming MADI up to 48kHz. This supports MADI sources 
that are not reference locked to the router.
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For More Information on...
• configuring the UltriSRC feature, refer to the Ultrix User Guide for your router.

UltriProc Overview
UltriProc allows you to perform color correction, Proc Amps, and HDR conversion on Ultrix I/Os. An 
UltriProc can be assigned to either inputs or outputs. A license key is required for each selected I/O 
that will be used by the UltriProc. 

Figure 49  Example of the UltriProc Interface in DashBoard

UltriProc color correction is performed in the Y'CbCr color space or by RGB Color Correctors in the 
RGB color space. It is additive, allowing you to apply any combination of SDR/HDR and RGB Color 
Corrector based adjustment to a video signal. 

The video input dynamic range and colorimetry/transfer characteristics settings can be manually 
configured or can be automatically detected from the SDI video input 352M payload identifier.

The video output dynamic range and colorimetry/transfer characteristics settings can be manually 
configured or can be automatically set to follow the SDI video input dynamic range and 
colorimetry/transfer characteristics.

For More Information on...
• configuring UltriProc, refer to the Ultrix User Guide for your router.

UltriStream Overview
The UltriStream licensed feature provides the ability to encode one NDI stream of a configured 
Ultriscape Multiviewer Head per ULTRIX-HDX-IO or ULTRIX-MODX-IO blade. 

 The Multiviewer Head for the video source must be one from the blade that is transmitting the 
NDI stream. For example, a licensed ULTRIX-MODX-IO blade in slot1 cannot send an NDI stream 
of a Multiviewer Head from a licensed ULTRIX-HDX-IO blade in slot2.

For More Information on...
• configuring UltriStream, refer to the Ultrix User Guide for your router.
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Monitoring
This chapter briefly summarizes how to monitor the ULTRIX-MODX-IO via the DashBoard interfaces.

Monitoring the Video and Audio Signals
Use the Ultrix > System > Monitoring interfaces provide options to monitor the video and audio 
signal status for any blade in the router. Refer to the ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 User 
Guide or the ULTRIX-FR12 User Guide for details.

Figure 50  Example of the Ultrix > System > Monitoring > Alarm Config Tabs

Monitoring the Hardware
Use the Ultrix > System > Ultrix > Device Configuration > Alarms interface to monitor any detected 
error conditions for the entire router. These can range from yellow (caution) to red (warning) 
messages about individual blades, modules, or ports. This interface reports messages based on the 
alarms enabled in the Frame Configuration > Alarms tab.

Refer to the ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 User Guide or the ULTRIX-FR12 User Guide for 
details.

To access the Alarms interface for the router

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Locate the Alarms area of the top toolbar.

6. Click Alarms.
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Figure 51  Example of a Device Configuration > Alarms > Temperature Caution

You can also use the Device Configuration > Port Configuration > Views > IO Module interfaces to 
monitor multiple ULTRIX-MODX-IO blades, a specific blade, a type of module, multiple ports, or a 
specific port. Refer to “IO Module Views” for details on the read-only fields of each interface.

Figure 52  Example of the IO Module > SFP > Inputs > SFP Statistics Tab
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Upgrading the Software
This chapter outlines how to use DashBoard to upgrade the ULTRIX-MODX-IO and the 
ULTRIX-MOD-NDI module in the field. 

Before You Begin
Keep the following in mind before upgrading the software:

• A fully loaded ULTRIX-MODX-IO blade can take up to 15 minutes to upgrade all its modules.
• The Ultrix router is temporarily taken off-line during the upgrade process.
• If an ULTRIX-MOD-NDI module is newly installed in a slot of the ULTRIX-MODX-IO blade and the 

module software does not match that of the blade, there is the option to perform a 
module-level-only upgrade (step 10 below). This upgrade will only affect the modules that do not 
match the blade software. 

Upgrading the Software via DashBoard
Upgrading the ULTRIX-MODX-IO and the ULTRIX-MOD-NDI requires three *.bin files: one for the 
Ultrix router, one for the ULTRIX-MODX-IO blade, and one for the ULTRIX-MOD-NDI module. 

To upgrade the software on the ULTRIX-MODX-IO

1. Contact Ross Technical Support for the latest software *.bin files. 

2. In DashBoard, navigate to the Ultrix > System > Configuration > Connections > Services tab.

3. Ensure the Enable Upgrades & Support Access box is selected.

4. Navigate to the Product Info interface for your router.

5. Verify that the Upload button displays on the interface.

6. Upload the Frame *.bin file.

This file upgrades the software for the router to work with the ULTRIX-MODX-IO.

7. Upload the Card *.bin file.

This file upgrades the software for the ULTRIX-MODX-IO blade.

8. Reboot the router.

9. Wait until the router returns from the reboot.

10. Upload the Module *.bin file.

This file upgrades the software for the modules installed in the ULTRIX-MODX-IO.

 The Module *.bin is uploaded to each module in the ULTRIX-MODX-IO blade serially. Each module 
takes approximately 3.5 minutes to upgrade.

11. Verify the software versions of the Frame, Card, and Module after upgrade to ensure that each 
was updated correctly.

• To view the frame software version: Select Ultrix > Ultrix > Product Info > Product > System 
Version.

• To view the blade software version: Select Ultrix > Ultrix > Port Configuration > View > IO 
Module > Card.

• To view the module software version: Select Ultrix > Port Configuration > View > IO Module > 
Module.
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Technical Specifications
This chapter provides technical information for the ULTRIX-MODX-IO blade only. Note that 
specifications are subject to change without notice.

Power Specifications
 Refer to the Ross Ultrix Configuration Tool on our website, or contact Ross Technical Support for 

help determining the power needs of your system. 

Environmental

Supported SFP Modules
Refer to the document ULTRIX SFP Modules Guide for more information on the supported SFP 
models and their specifications.

Table 33  Technical Specifications — Power Supply Ratings

Item Specifications
ULTRIX-MODX-IO 90W

Per Module 15W

Total 150W

Table 34  Technical Specifications — Environmental

Item Specifications
Max. Ambient Temperature Range 0°C to 40°C (32°F to 104°F)

Humidity, non-condensing < 95%
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